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A.

Al

EQUIPMENT

Survey Vessel: R/V Ocean Explorer

All survey operations were conducted from the R/V Ocean Explorer (Figure 1). R/V Ocean
Explorer, O.N. 905425, is an 18-meter aluminum vessel, with a 5.1-meter beam and nominally
2-meter draft. R/V Ocean Explorer is powered by two 1,000 HP Iveco diesel engines.

fesm i —

Figure 1. R/V Ocean Explorer configured for hydrographic survey operations.

The R/V Ocean Explorer was modified to support hydrographic survey operations by Ocean
Surveys, Inc., hereinafter referred to as OSI. The following summarizes the major adaptations
and/or custom survey support hardware installed on the R/V Ocean Explorer:

1.

2.

Survey system control modules (processors) and computer systems were installed at
purpose-built work stations in the main cabin of the vessel.

A measured and indexed Inertial Measurement Unit (IMU) mounting plate was
installed on the vessel’s fore-aft (roll) centerline at the approximate pitch center of
rotation. The POS MV IMU was installed on this plate which resides approximately
0.5 meters below the plane of the vessel waterline.

A retractable multibeam transducer pole, constructed of thick-wall aluminum pipe, was
attached to the starboard side of the vessel at the approximate pitch centerline. The
pole was attached at two points: a substantial, positive locking swivel near the deck of
the vessel and a “receiver plate” at the chine of the vessel. The transducer pole is
forced, by means of a block and tackle system using non-stretch rope and a hand-crank
winch, into the V-notch receiver plate, thereby eliminating pole movement. The
transducer pole was fitted with fairings on the trailing edge to minimize cavitation. The
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bottom of the transducer pole was fitted with a termination flange configured with a
small copper orifice. This configuration allowed the transducer pole to be used as a
stilling well.

4. To support “fixed mount” side scan sonar (SSS) operations a substantial, custom
fabricated, SSS mounting bracket was affixed to the forward side of the multibeam
transducer pole (described above). The fixed mount SSS bracket was installed
approximately 0.4 meters above the multibeam transducer which was at the bottom of
the transducer pole.

5. To support towed SSS operations a hydraulically actuated A-frame was installed on the
stern of the vessel. The SSS towfish was flown from the starboard side of the A-frame
as close as practical to the athwart ship position of the multibeam transducer pole. An
electric, multi-purpose, slip ring winch was installed on the main deck and was used to
control the towed SSS.

6. A moving vessel profiler (MVP) was installed on the port quarter of the vessel.

A full survey of the R/V Ocean Explorer was conducted on May 6, 2015 by OSI during which
reference points (permanent shipboard benchmarks) were established onboard the vessel to
define a fixed reference frame, vessel reference point (RP), draft measurement locations and
sensor mounting locations. These points were “surveyed” using a precision total station optical
theodolite and electronic distance meter while the vessel was hauled out and blocked on land.
Offsets measured during the 2015 total station survey were confirmed during the 2016 vessel
mobilization employing a steel tape measure.

The multibeam transducer pole is capable of variable draft settings. During the 2016 vessel
mobilization the initial transducer phase center-to-RP value was established relative to
shipboard benchmarks employing a steel tape measure. Survey offsets and estimated
measurement accuracies were incorporated into the CARIS vessel configuration file.

Major data acquisition system components that were employed during the project are
summarized in Table 1 below. A brief description of the equipment follows.
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Table 1
Acquisition Equipment
Model/ Firmware/Software Serial
System Data Manufacturer Version No. Ver. Number (s)
Side Scan
Sonar Towfish | Imagery/Contacts EdgeTech 4125 N/A 46118
(fixed-mount)
Side Scan 4125D
Sonar Imagery/Contacts EdgeTech 4125P V. 35.0.1.104 46921
Processor
Side Scan | 1 ery/Contacts | EdgeTech 4200-MP N/A 48869
Sonar Towfish gery & )
Side Scan | 1 cery/Contacts | EdgeTech 4200-MP N/A 48742
Sonar Towfish gery/iontacts gelee
Side Scan )
Sonar Imagery/Contacts EdgeTech 701-DL Discover 4200-MP 48825
V. 35.0.1.104
Processor
Multibeam
Echosounder Soundings Reson 7125 SV2 SV2 SP4 7K 6,0,0,6 | 18342213063
Processor
Multibeam .
Echosounder Soundings Reson 7125 SV2 N/A Proj. 4712049
Rec. 0213063
Transducer
. MicroX
Surfgczj;und Sound Speed AML ng‘ggéﬁa\g/e N/A 10315
P g SV-X 201527
Moving Vessel | ¢ 4 gpeed ODIM MVP30 MVP Controller 2.43 10646
Profiler (MVP) '
Micro SVPT SV-X-203108
SI\I/)IG\:Q; i(r)ggfe Sound Speed AML SV-Xchange & N/A PT-7786
Sensors (2) Oceanographic | Pressure/Temp SV-X-201525
Sensor PT-7777
. Base-X Base X-25028
ol | Sound Speed | Oceanographic | SV Xehanee 415 SV-X 203516
p grap P-Xchange P-X 303077
Navigation Position TPU 6415
Vessel Attitude Attitude, Applamx/ POS MV 320 HW 1.2-10 (use.d'dur'lng
& Headin Headin Trimble V.5 SW 07.92 mobilization)
g £ IMU 497
Navigation Position TPU 3352
gation, o, Applanix/ | POS MV 320 HW 1.1-7 (used during
Vessel Attitude Attitude, . .
& Heading Heading Trimble V.4 SW 05.03 project)
IMU 497
Navigation Position Trimble SPS 461 488.01 5622R80094
-3- Data Acquisition and Processing Report




OPR-K354-KR-16

OCEAN SURVEYS, INC.

Model/ Firmware/Software Serial
System Data Manufacturer Version No. Ver. Number (s)
U.S.C.G.
Differential . 0220096149
Beacon DGPS correctors Trimble ProBeacon 3 0220181937
Receivers (2)
SSS Cable . .
Payout SSS Fish Hydrographic SCC16” 3 2027
; Layback Consultants
Indicator
Land Survey | RTK GPS Base Trimble 5700 V3.0 220247153
GPS Station
Water Level "\ giatic Draft GEDruck | PDCR-830 N/A 363764
Gauge
Bottom Mounted .
\nglerelge(\gl Pressure Gauge E?;::lt-r]z;riis SBE-26 3.1 189 and 219
& (BMPG) “Tide”
Determination of
Conductivity | Seawater Density Sea-Bird SBE-37 SMP 41 11494 and
Sensors (2) to support Electronics and SBE 4M ’ 042031
BMPG Tide
Lead Line Bar Check OSI Lead Disk N/A 2010B
Stadia Rod Static Draft Crain CR-4.0M N/A OSI SR-02
. . . 20212221
Autopilot Vessel Steering Simrad AP50 VIR4 DA1711
A2 Echo Sounding Equipment
A2.1 Side Scan Sonar Systems
A.2.1.1  EdgeTech 4125

The fixed-mount or “pole mount” SSS system was an EdgeTech 4125 dual-frequency CHIRP
system operating at a nominal frequency of 600 kHz. The second frequency, 1,600 kHz, was
not enabled during this survey. This sonar was operated at the 50 m range scale only and used
in the shallow reaches of the survey area. The system consists of a portable Topside Processing
Unit (TPU) and sonar towfish. The towfish was equipped with an optional telemetry package
that allowed for towfish-TPU communication via a coaxial cable connection. The towfish was
equipped with standard sensors for pitch, roll, heading, and depth (pressure). However, given
that the system was affixed to the multibeam pole, none of these sensor data were used during
data processing. The TPU connected to the SSS acquisition computer through a dedicated
Ethernet cable. A 4125 SSS positioning verification test was performed in the vicinity of the
vessel’s home port on July 26, 2016 (DN 208) and is documented in the DAPR Appendix II:

4 -

Data Acquisition and Processing Report




OPR-K354-KR-16 OCEAN SURVEYS, INC.

Echosounder Reports. Positioning accuracy was verified during the course of the survey by
observation of coincidental adjacent and/or reciprocal data.

Figure 2. Pole-mounted EdgeTech 4125 SSS transducer as configured for Project OPR-
K354-KR-16. Note that the SSS transducer module (pointing down in this photo) is
separated from the electronics module which is secured parallel to the forward side of
the transducer pole. A Reson 7125 transducer is mounted to the bottom of the pole in
this photo.

A.2.1.2  EdgeTech 4200-MP

An EdgeTech 4200-MP (multi-pulse) side scan sonar system was used to acquire imagery in
the deeper reaches of the project area within Survey H12908. The 4200-MP employed on this
project is a dual-frequency sonar capable of operating at 300 kHz and/or 600 kHz. For this
survey the system was operated in dual-frequency mode employing the “high speed” mode
exclusively. Of the available range scales, only the 75-meter setting was used. The system
consists of a Topside Processor Unit (TPU), coaxial double-armored steel tow cable, electric
powered slip ring winch, digital cable payout meter, and sonar towfish. System components
were interfaced to the acquisition system and other ancillary devices, via a local network hub
or serial cable connections. The towfish was equipped with a pressure sensor which was used
to measure towfish depth. The towfish was fitted with a hydrodynamic depressor wing.
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Positioning verification testing was completed in the vicinity of the vessel’s home port on July
26, 2016 (DN 208). The SSS calibration test results are documented in the DAPR Appendix
II: Echosounder Reports.

Figure 3. EdgeTech 4200-MP towfish as configured for Project OPR-K354-KR-16.

A22 Multibeam Echosounder
A22.1 Reson SeaBat 7125 SV2

The SeaBat 7125 SV2 is a dual-frequency Multibeam Echosounder (MBES) System with
operational frequencies of 200 kHz or 400 kHz. For Project OPR-K354-KR-16, the
echosounder’s 400 kHz capability was employed. At this frequency and at the beam spacing
basis chosen for this project, the 7125 system illuminates a swath of the seafloor that is 140°
across track by 1° along track with a maximum ping rate of 50 Hz. The system can be
configured with numerous beam density and swath angle combinations. The 512-equidistant
beam configuration was used for Project OPR-K354-KR-16. For this project the swath width
was reduced to 130° as experience has shown degradation of data quality at the outer limits of
the 140° swath especially in a dynamic sound speed setting as is typically encountered in
coastal Gulf of Mexico waters. The manufacturer’s stated depth resolution is 6 mm. This
sonar system, as employed, is designed to comply with International Hydrographic
Organization (IHO) standards to measure seafloor depths to a maximum range of 175 meters.
Digital data were output through the Ethernet data port and displayed in real time on a high-
resolution color monitor.
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Figure 4. Pole-mounted Reson 7125 transducer as configured for Project OPR-K354-KR-16.

The transducer X, Y, Z position and angular offsets [relative to the vessel frame and a vessel
reference position (RP)], were referenced to values derived during the 2015 full static survey
with values confirmed prior to the 2016 survey. A patch test and performance test were
completed during mobilization in Connecticut. However, the initial patch test of record was
performed in Morgan City, LA on August 16, 2016 (DN 229). The initial performance test of
record was performed within the survey area on August 25, 2016 (DN 238). Given that the
multibeam system is deployed on a retractable pole, in order to maintain confidence that the
deployed pole was stable, multiple interim “roll” patch tests were performed throughout the
course of the survey. In practice, reciprocal multibeam data were collected on a short set of
lines at a convenient time each day and processed onboard to confirm system stability. In cases
where the pole was deployed after transit, e.g. after returning to the survey area after a port
call, a roll test was conducted immediately prior to data acquisition. In all cases, results of
interim roll testing indicated that the multibeam pole was stable. Verification or “close out”
patch and performance testing of record was performed at the completion of the project on
September 30, 2016 (DN 274). The patch test and performance test results of record are
presented in DAPR Appendix II.
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A3 Manual Sounding Equipment
A3l Lead Line

The lead line was constructed by OSI utilizing a 9 kilogram, 0.3-meter round lead disk attached
to a stainless steel cable with permanent index markers established at measured 1-meter
intervals (from 1-10 meters) and then 2-meter intervals thereafter.

Prior to survey operations the lead line was calibrated on July 12, 2016 (DN 194) with a steel
survey tape to verify index mark accuracy (see DAPR Appendix II for results).

A4 Positioning and Attitude Equipment
A4.1 Applanix POS MV

An Applanix POS MV 320 V.4 system was installed on the survey vessel to provide position
and attitude data. The POS MV (Position and Orientation System for Marine Vessels) consists
of a rack mountable POS Computer System (PCS), a separate Inertial Measurement Unit
(IMU) and two GPS receivers.

The POS MV combines the IMU and GPS sensor data into an integrated and blended
navigation solution. Per manufacturer’s literature there are two navigation algorithms
incorporated into the system, namely a tightly coupled and a loosely coupled inertial/GPS
integration. Tightly coupled inertial/GPS integration involves the processing of GPS pseudo
range, phase and Doppler observables. In this case, the GPS receiver is strictly a sensor of the
GPS observables and the navigation functions in the GPS receiver are not used. With loosely
coupled inertial/GPS integration, the GPS position and velocity solution are processed to aid
the inertial navigator.

The POS MV generates attitude data in three axes (roll, pitch and heading). Roll and pitch
measurements are made within an accuracy of 0.02°. Heave measurements supplied by the
POS MV maintain an accuracy of 5-centimeters or 5% of the measured vertical displacement
for movements that have a period of up to 20 seconds.

The GPS Azimuth Measurement Subsystem (GAMS) allows the POS MV system to achieve
high-accuracy heading measurement. The GAMS subsystem uses two GPS receivers and
antennas to determine a GPS-enhanced heading that is accurate to 0.02° or better (using an
antenna baseline > 2 meters) when blended with the inertial navigation solution. The system
uses this heading information together with the position, velocity and raw observations
information supplied by the primary GPS receiver. GAMS heading was employed for all
survey data acquisition and GAMS status was monitored continuously during survey
operations using the MV-POSView controller software.

IMU and antenna offsets and mounting angles, relative to the vessel frame and a vessel RP,
were measured during the 2015 full static survey (values confirmed prior to the 2016 survey).
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An Applanix-specified GAMS calibration procedure was conducted during mobilization on
July 26, 2016 (DN 208) prior to acquisition of any of the calibration data of record. This POS
MYV (TPU 6415) was employed during SSS positioning verification testing and the settlement
test. A satellite phone system was installed on the boat after this date. It was soon discovered
that the satellite phone system interfered with GPS satellite reception on the POS MV. For
this reason a second POS MV processor was installed on the vessel and a GAMS calibration
was performed on July 31, 2016 (DN 213). The second POS MV processor (TPU 3352) used
a different GPS antenna model which was immune to satellite phone interference. The second
POS MV was employed for the remainder of the project including acquisition of all MBES
patch/performance testing of record. The IMU was not changed when the topside processor
was changed, i.e. the IMU originally installed was used throughout the entire project.

A4.2 DGPS

Individual Trimble Pro Beacon DGPS beacon receivers were manually tuned to one of the two
local USCG differential beacon stations and interfaced, as signal quality dictated, to the POS
MV. Refer to the Vertical and Horizontal Control Report for additional details of DGPS
position correctors. Occasionally the primary DGPS corrector source, English Turn, LA would
become unusable due to station maintenance or nearshore weather. In these cases the
secondary DGPS signal from Angleton, TX was utilized.

A43 Other Positioning and Attitude Equipment
A.4.3.1  Secondary Positioning: Trimble SPS 461

A secondary or “position integrity alarm” GPS system consisted of a Trimble SPS 461 GPS
operating in pseudo-RTK mode. This GPS system was supplied with “HP” correctors from
the Marinestar subscription corrector service using the Omnistar G2 engine mode.

For the purposes of a NOS tide gauge/tidal zoning-controlled survey, the positioning accuracy
afforded by the SPS 461 is much better than required. This system was primarily employed to
assist in determining the vertical stability of the bottom mounted pressure gauge (BMPG) data
acquired during the survey. BMPG data were acquired to support improvement, if applicable,
of CO-OPS provided preliminary tide zoning. The SPS 461 was only needed at the beginning
and end of BMPG deployment to facilitate “boat float” observations (see HVCR for additional
information). However, given that the system was installed onboard the vessel in the support
role described above, it was employed throughout the survey in the positioning integrity alarm
role.

A43.2 SSS Cable Out Indicator

Determination of SSS cable out values was accomplished by means of a Hydrographic
Consultant, Ltd. SCC Smart Sensor Cable Payout Indicator. The payout indicator consists of
a topside display/controller, deck cable, and 16-inch (0.4-meter) diameter block fitted with a
magnetically triggered counting sensor.
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The cable out indicator was calibrated according to manufacturer specifications before data
acquisition by measuring the sheave circumference and entering a calibration value into the
topside controller software.

The accuracy of the system was checked repeatedly during towed SSS operations by
comparing sensor display values to calibration marks on the tow cable. These checks were
performed frequently during each survey day. The counter system was recalibrated as-needed
to account for minor cable slippage.

A5 Sound Speed Equipment

The surface sound speed sensor, the sound speed comparison profiler, and the undulating
velocimeter (ODIM MVP) sensors were all fitted with AML Oceanographic instruments which
were manufacturer calibrated prior to survey data acquisition. Copies of the calibration sheets
are included in DAPR Appendix IV.

A5.1 Sound Speed Profiles
A.5.1.1  Sound Speed Profiler: ODIM MVP30

The ODIM MVP30 Moving Vessel Profiler allows sound speed profiles to be collected while
the vessel is underway. The ODIM MVP consists of towfish-mounted sensors (AML sound
speed, temperature, and depth “micro SVPT”), an electro-mechanical conductor cable, and an
electric winch. The MVP may be deployed manually using the winch controls or remotely
using the ODIM MVP Controller Software. When operated in “FreeWheel” mode while
underway, the MVP falls near-vertically to a preset depth off the bottom, collecting sound
speed and temperature/depth measurements at a frequency of 10 Hz. The MVP30 was the
primary sound speed profiler employed during this survey. Sound speed data from the AML
Base-X used for comparison casts and the AML Micro-X surface sound speed sensor at the
MBES transducer head were frequently referenced to confirm proper operation of the MVP30
AML sensors.
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Figure 5. ODIM MVP30 as mounted on the vessel stern.

A.5.1.2  Sound Speed Profiler: AML Oceanographic Base-X

An AML Oceanographic Base-X logging profiler was employed to acquire comparison cast
data for “monthly” sound speed confidence checks. In fact, sound speed confidence checks
were performed almost daily during the course of the survey. This instrument collects high-
precision direct sound speed and pressure measurements. The instrument was configured to
take measurements at a rate of 5 Hz. These data were stored internally and downloaded via a
serial connection using the field logging computer.

In practice this instrument was attached to the MVP30 freefall fish and manually deployed to
the deepest practical depth while both instruments logged data. Data from both instruments
were compared employing utilities within NOAA’s Velocwin program.

A5.2 Surface Sound Speed: AML Micro-X

The AML Micro-X is a high-accuracy sound speed sensor capable of measuring and
transmitting sound speed data directly to the MBES via a manufacturer-supplied data cable.
The Micro-X, mounted within the bow faring of the MBES transducer, transmitted real-time
surface sound speed data to the Reson 7125 multibeam system and the HYPACK acquisition
computer via the Reson interface. The Micro-X, like the AML SVPT and Base-X sensors
discussed above, uses a sound speed “exchange” sensor.
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A.6 Horizontal and Vertical Control Equipment
A.6.1 Precise Positioning: Trimble 5700 GPS

Prior to and during the course of the survey the accuracy of the primary positioning system
was verified by means of a physical measurement to temporary horizontal control/navigation
checkpoints located at the vessel’s base of operation. The checkpoint was established using a
Trimble 5700 GPS system configured with a Trimble Zephyr Geodetic antenna.

A.6.2 Pressure Gauge: GE/Druck Water Level Gauge

Data from a GE/Druck pressure sensor were used to calculate vessel static draft values while
the vessel was offshore. The water level system consists of a vented pressure transducer
connected to a top-side voltage converter. The system transmits a serial “depth” string to the
HYPACK logging computer. The pressure transducer was installed well below the waterline
at a fixed elevation within the multibeam transducer pole. As mentioned earlier, the otherwise
sealed base of the multibeam pole was configured with a small copper orifice, in effect making
the transducer pole a stilling well. The physical offset between the sensor “depth” and vessel
draft was established dockside during a series of physical draft measurements versus sensor
value observations (static dockside calibration).

During offshore operations, sensor data were logged once a day (when practical) when the
vessel was at full stop. The system was configured to record a water level at a rate of 20 Hz.
Water level readings were logged to a HYPACK .RAW file for 5-10 minutes while the vessel
was at a full stop. The average sensor value for the term of the observation was used for each
offshore static draft calculation. Sensor readings were adjusted based on the derived fixed
offset value established during the static dockside calibration procedure. This approach
allowed the field team to accurately track vessel static draft despite offshore conditions.

A.6.3 SBE Pressure Gauges and Conductivity Sensors

Per the recommendation in the Tides and Water Levels Statement of Work bottom mounted
pressure gauges (BMPG) with associated conductivity and temperature sensors were deployed
at the southwestern corner of the survey area to support gaining a “better understanding of tidal
propagation and error associated with tidal zoning.” To this end redundant BMPG instrument
packages were installed.

The primary BMPG instrument package comprised a 45 PSIA SBE-26 pressure sensor and a
SBE-37 SMP conductivity sensor. The backup instrument package comprised a 200 PSIA
SBE-26 pressure sensor and a SBE-4M conductivity sensor. Temperature was recorded via
both SBE-26 instruments as well as the SBE-37 SMP.

The instrument packages were deployed on substantial moorings. Deployment and recovery
was accomplished with the R/V Ocean Explorer. OSI’s tides subcontractor, JOA Surveys,
processed the tide data. The BMPG tide station package was delivered to CO-OPS via e-mail
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on November 9, 2016. A copy of the JOA Surveys tide zoning report is included in HVCR
Appendix II. The entire JOA Surveys submittal in included in HVCR Digital A.

Figure 6. Primary BMPG prior to deployment.

A.64 Stadia Rod

A fiberglass stadia rod was employed throughout the survey for various tasks requiring a rigid
measuring tool. Due to the relatively high freeboard of the R/V Ocean Explorer, manual static
draft measurements were accomplished employing the stadia rod. Static draft measurements
were made relative to permanent shipboard benchmarks which were related to the vessel RP
during the full vessel survey. Prior to utilization, the rod graduations were compared to a steel
tape measure to confirm accuracy.

A7 Additional Acquisition Equipment
A.7.1 Bottom Sampler

A sediment sampler was employed to obtain seafloor sediment samples within the survey area.
A hydraulic pot hauler aboard the R/V Ocean Explorer was employed to recover the unit.
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A7.2 Auto Pilot

A Simrad AP50 Marine Autopilot was installed to steer the vessel during concurrent MBES
and SSS mainscheme data acquisition. When activated, the Autopilot controlled the rudder
adjustments to keep the vessel on line.

A8 Computer Hardware and Software

A8.1 Computer Hardware

Table 2
Computer Hardware

Use Manufacturer Model Operating System

MBES Acquisition OSI Custom Build OSI Custom Windows 10 64-bit

SSS Acquisition OSI Custom Build OSI Custom Windows 10 64-bit
MVP Acquisition Hewlett Packard HP 530 Windows XP

Onboard Data QA/QC OSI Custom Build OSI Custom Windows 10 64-bit

MBES acquisition was accomplished using HYPACK software installed on a Windows 10 64-
bit computer having a MSI Military Class 4 Motherboard, a 3.2 GHz Intel Core i5 quad core
processor, redundant 250 gigabyte (GB) solid-state program drives, redundant 2 terabyte (TB)
internal data hard drives, three gigabit network adapters, 16 GB of RAM, dedicated graphics,
multiple display monitors, 9 serial ports and multiple USB-3 ports. This computer was also
used to control and monitor the POS MV using the MV POSView controller and to record
POSPac data.

SSS data were logged with EdgeTech Discover software on a second computer custom built
exactly as the computer described in the paragraph above. This computer was also used to run
a separate instance of HYPACK SURVEY which was dedicated to providing autopilot
commands.

Onboard data QA/QC was accomplished on a third computer, identical to that described above,
with one exception. Given that this computer was utilized as the data backup hub it was fitted
with redundant 3 TB internal hard drives rather than the 2 TB drives installed in the collection
computers. External backups were made using this computer.

Data processing was completed at the home office using multiple Windows 10 64-bit
computers with the following typical hardware specifications: 3.40 GHz Intel Core 17-4930K
processor (6-core/12-thread), 120 GB primary SSD, 2 TB RAID 0 (high-performance) SSD
data drive, two 2 TB hard drives in RAID 1 (redundant) configuration, 16 GB of RAM, dual
graphics cards, and four high-definition displays. The multiple computers shared data over a
10 gigabit local area network.
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A.8.2 Computer Software

Computer software utilized during this survey is itemized in Table 3 below.

Table 3
Computer Software
Manufacturer Application Version Version Date
HYPACK HYPACK SURVEY 13.0.9.28 Sept. 26, 2013
HYPACK HYSWEEP SURVEY 13.0.20.0 Oct. 15,2013
EdgeTech Discover 4125D 5.00 35.0.1.104 May 19, 2015
EdgeTech Discover 4200-MP 4.00 35.0.1.104 May 19, 2015
Teledyne CARIS HIPS/SIPS 7.1.2 SP2 2012
Teledyne CARIS Notebook 3.1.1 SP1 2011
HYPACK MBMax 13.0.1.0 Jan.28, 2013
Chesapeake Technology Sonar Wiz 5 5.1.0.40 Sept 4, 2013
NOAA NOAA Velocwin 8.92 May 8, 2008
AML Oceanographic SeaCast 425 May 27,2016
Microsoft Office (Word, Excel) 2016 | 16.0.6965.2058 | June 3, 2016
ODIM Brooke Ocean MVP Controller 2.430 Jan. 20, 2010
Applanix MYV POS View 7.92 April 9, 2014
Applanix POSPac MMS 7.1 June 8, 2016
Global Mapper Software LLC Global Mapper 13.2 June 20, 2012
AutoDesk Inc. AutoCAD 2004 Feb. 14, 2003
Hydrographic Consultants CALLOAD 2.0 Dec. 18, 2005
Trimble Pro Beacon (DOS) N/A Sept 12, 1994
Trimble GPS Configurator 4.10 March 20, 2013
National Geodetic Survey OPUS and OPUS-RS 2.3 July 7, 2016
Sea-Bird Electronics Seasoft for Waves 2.0 June 23, 2011
Sea-Bird Electronics Seaterm V2 2.2.6 March 5, 2013

A.8.2.1 HYPACK SURVEY

Survey vessel trackline control and position fixing were accomplished by using the HYPACK
SURVEY data-logging and navigation software package. Vessel position data were output
from the POS MV at 50 Hz frequency and transmitted to the navigation computer system,
which processed these data in real-time into the desired mapping coordinate system (UTM
Zone 15 North, NAD 83). Raw and processed position data were continuously logged onto
the computer hard drive, sent to the autopilot, and displayed on a video monitor, enabling the
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vessel’s helmsman (and autopilot) to guide the survey vessel accurately along pre-selected
tracklines. Tracklines and survey features were displayed on the helm monitor with geographic
reference data that included current NOS raster nautical charts (RNCs) and other pertinent
survey reference files.

Motion and predicted tide-corrected sounding data were displayed as HYPACK gridded depth
models and coverage matrices. HYPACK “targets” were also recorded to mark the location
and time of significant observations during data acquisition, such as MVP or Base-X cast
positions, bottom sample locations, and side scan targets of interest. Raw, geographic position
data (NADS83 degrees latitude and longitude) were time tagged with UTC time by the POS MV
and recorded by HYPACK SURVEY in .RAW format line files.

The HYPACK computer was also used for sensor monitoring and data quality review while
data were acquired. Ultilities in the acquisition module of HYPACK notify the operator with
a visual alert in the event of a sensor malfunction or, in some cases, when a sensor parameter
drifts out of operator-set limits (e.g. DGPS position comparison or surface sound speed
change).

HYPACK SURVEY was used to generate real-time SSS positioning which was transmitted to
and recorded by the individual instances of Discover SSS software. In the case of pole-
mounted 4125 SSS, HYPACK’s “Genoffset.dll” was used to calculate SSS fish position. In
the case of the towed 4200 SSS, HYPACK’s “Towfish.dll” was used to calculate SSS fish
position. These processes are described in more detail in Section C.1.4. Towtfish position
parameters applicable for each system, e.g. depth, cable out, layback, and position, were
recorded in the HYPACK RAW data, and the real-time position was sent to the individual
instances of Discover to serve as primary positioning for each SSS system.

A separate instance of HYPACK SURVEY was run on the side scan sonar acquisition
computer, which was also used to control the autopilot. Each acquisition computer’s
HYPACK SURVEY program was configured to use GPS UTC time to continuously sync the
computer time. Both the MBES and SSS acquisition PCs were synced using the Group 7
message from the POS MV.

A.8.22 HYSWEEP SURVEY

Multibeam data were logged with HYPACK HYSWEEP software which was run
simultaneously with HYPACK SURVEY. Multibeam raw beam ranges, intensities, and
quality flags were time tagged with UTC time by the Reson 71P processor and recorded by
HYSWEEP in HSX format line files.

Motion and attitude data (heave, pitch, roll, and heading) were time tagged with UTC time by
the POS MV and recorded by HYSWEEP in HSX format line files.

Multibeam backscatter data were recorded via HYSWEEP SURVEY in HYPACK .7K format.
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A.8.2.3  EdgeTech Discover 4125D and 4200-MP

Discover is a side scan sonar control and acquisition software that interfaces directly with the
EdgeTech SSS systems via a dedicated Ethernet connection. Each instance of the software was
installed and operated on the SSS acquisition PC running the Windows 10 64-bit operating
system. The majority of the EdgeTech settings are controlled within this software; these
include the specific sensor inputs/outputs, side scan range settings, display gains, color
palettes, real-time bottom tracking parameters, file recording characteristics, pressure sensor
zero depth calibration (if applicable), altitude alarms, and navigation offsets.

According to the equipment manufacturer, Discover 4125D and 4200-MP are identical
versions of the same Discover program. The different name suffix is applied during the
software installation depending on which EdgeTech sonar system folder the installer accesses
on the manufacturer’s FTP site. One advantage to running two versions of the same program
is that the data from each system (4125 and 4200) is written to independent folders if a single
acquisition computer is employed as was the case during Project OPR-K354-KR-16. Although
it is possible to do so, there was not a need on this project to operate the independent systems
concurrently.

Both instances of Discover received fish position information from the HYPACK SURVEY
program via discrete serial connections to the HYPACK computer. For this reason, all
navigation offset settings within each instance of Discover were set to zero.

For the rigid pole-mount configuration, HYPACK SURVEY calculated and transmitted fish
position based upon the fixed physical offsets of the EdgeTech 4125 SSS relative to the vessel
RP.

When the towed side scan configuration was implemented, HYPACK SURVEY calculated
and transmitted fish position based on required and recorded inputs such as tow sheave position
relative to the vessel RP, “cable out,” and fish depth as transmitted in the form of a NEMA
“DPT” message by the EdgeTech 4200. Fish altitude, another required parameter, is calculated
by HYPACK SURVEY based on water depth and fish depth.

In addition to receiving position, Discover was configured to accept an ancillary time input. A
NMEA ZDA message was generated by the POS MV and delivered to each instance of
Discover over a serial connection. The software used this timing message to sync its time and
the EdgeTech 4125/4200 TPU time to UTC.

All SSS scrolling waterfall data displays were configured to display uncorrected side scan
sonar imagery. These displays were arranged on a vertically oriented high-definition IPS (In-
plane switching) display. Scrolling imagery was continuously reviewed during collection for
data quality, feature detection, and to identify water column noise and/or interference (e.g. fish,
boat wakes, refraction, etc.). System and user alarms were monitored to ensure continuous
system functionality.
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Each instance of Discover compiled system specific side scan sonar image data along with
position records and stored these data in EdgeTech .JSF format. Based on past project
experience, OSI has determined that JSF files produce superior imagery in CARIS. Therefore,
XTF data were not recorded for this project.

A.82.4  CARIS HIPS and SIPS

All multibeam echosounder data were converted from raw HYPACK format data files to
HDCS format and processed using CARIS Hydrographic Information Processing System
(HIPS) software Version 7.1.2 for 64-bit processors.

All SSS data were converted from raw JSF format line files to HDCS format and processed
using the CARIS SIPS software Version 7.1.2 for 64-bit processors.

HIPS/SIPS Version 7.1.2 was also utilized to process MBES and SSS calibration data, which
included MBES patch and performance tests, and SSS position confidence tests.

CARIS SIPS Version 7.1.2 was employed to create the final MBES coverage surfaces and SSS
mosaic data deliverables.

A.8.2.5 CARIS Notebook

Notebook was used during home office processing to track and organize side scan sonar targets
of interest, i.e. significant targets and targets requiring further investigation. Danger to
Navigation (DtoN) submittals were compiled in Notebook and exported using Notebook in the
NOS Hydrographic Specifications and Deliverables (HSSD)-specified format, an S-57 .000
file. Field investigation assignments were tracked and conveyed to the field team using, among
other tools, HOB files created in Notebook.

Notebook was also used to complete chart comparisons and to generate the SSS Contact and
S-57 Final Feature Files.

A.82.6 HYPACK MBMax

MBMax was used for various shipboard and home office support functions such as patch test
data processing and performance test data processing as well as general data QA/QC review.
MBMax patch and performance test data processing were accomplished as a QA/QC measure
and to validate the CARIS-derived values.

A.8.2.7  Chesapeake Technologies, Inc. (CTI) SonarWiz 5

CTTI’s SonarWiz was used frequently aboard the survey vessel for various SSS QA/QC
functions such as image quality review and positioning accuracy confirmation.
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A82.8 NOAA Velocwin

Velocwin was used to convert the MVP sound speed cast data into CARIS SVP format. Along
with the AML Oceanographic data processing software, SeaCast, and Microsoft Excel, the
Velocwin software was also used for daily/weekly sound speed comparisons. All sound speed
instrumentation used on this project measures sound speed directly, i.e. the HSSD-imposed
prohibition on Wilson’s sound speed equation, used by Velocwin to process CTD casts, does

not apply.

A.8.2.9  AML Oceanographic SeaCast

Comparison sound speed cast data were acquired using an AML Oceanographic Base-X
system. The software used to interface with the Base-X instrumentation is AML’s SeaCast
software. This software was used to configure the instruments for deployment and to download
the raw cast data. Since the data collected during each cast were continuous during deployment
(i.e. collected during equalization, and both the down and up cast data), the data had to be
processed to create a useable down-cast file. The processing of the raw cast data was
accomplished using an OSI-developed Excel workbook.

Routines contained within the customized Excel workbook read in a raw SeaCast exported
data file, convert the pressure data to depths, isolate the down cast, plot the data, and generate,
among other things, the corresponding Velocwin-compatible .ZZQ file used in processing a
comparison cast with Velocwin.

A.8.2.10 Microsoft Office Word and Excel

MS Word was used for report generation. MS Excel was used for log keeping (acquisition and
processing), organization and preparation of field and office tasks, report figure production and
statistical data analysis. Excel was also used to reformat sound speed/depth data into the .ZZQ
format files for use in Velocwin’s weekly comparison cast utility.

A.8.2.11 ODIM Brooke Ocean MVP Controller

A dedicated laptop computer was used to operate the ODIM MVP30 Controller Software. The
System Configuration Window was used to interface the MVP towfish, MVP winch and the
navigation and depth data strings output from HYPACK. Position, depth and vessel speed data
were received from HYPACK and sound speed profiles were exported to HY SWEEP to be
used for real-time correction of the multibeam waterfall display.

The deployment configuration, alarms and data logging options were set in the Configuration
Window, including profile depth limit, max cable out and docked cable out. Sound speed
profiles (SV Files) were saved to the MVP laptop and the .CALC files were post processed
and converted to CARIS .SVP files using Velocwin. During manual casts, completed nearly
once per day with the vessel at rest, the MVP fish was allowed to reach near full water depth.
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The Main Operator Window was used to remotely “cast” the towfish and to monitor the towfish
parameters and alarms. Graphical tabs in the Main Operator Window were used to monitor
towfish depth and surface sound speed. The “view profile” button was utilized to review the
current sound speed profile. The manual logging option was toggled on during the acquisition
of stationary water column, MVP casts.

A.8.2.12 Applanix MV POSView

The MV POSView controller software was used to configure and monitor the POS MV
navigation and motion systems. IMU parameters (heave, pitch, roll), navigation and GAMS
status were monitored continuously at the navigation and acquisition stations. Visual alarms
were configured to alert the operator in the event that attitude, position, velocity, heading or
heave accuracy was degraded.

MV POSView was also used to start and end logging for daily POSPac files which contain
True Heave data and are used for various QA/QC analysis.

A.8.2.13 Applanix POSPac MMS Post-Processing Data

POSPac MMS is a post-processing software module, which, given acceptable distance and
geometry between the survey vessel and nearby Continuously Operating Reference Stations
(CORS) stations, significantly increases the efficiency, accuracy, and robustness of mapping
and surveying using GPS data. Using POSPac MMS in post processing, reliable decimeter
level or better accuracy can be obtained from existing reference station networks without
having a dedicated station located close to the project area.

POSPac data were acquired during survey operations primarily so the TrueHeave component
of the solution was available for application to MBES data.

Inertially Aided Post Processed Kinematic (IAPPK) position and attitude, was not applied to
the MBES data as the area of operation did not fall within a network of shore-based CORS
stations. However, POSPac MMS was used to create input files used in BMPG data analysis,
i.e. the POSPac-derived real time “tide” curve was compared to and in fact used to supplement
the Marinestar RTK-GPS-derived tide curve that was ultimately used in BMPG datum
determination (see section A.4.3.1). In this case an “IN-Fusion SmartBase” IAPPK solution
was used.

A utility developed by OSI was used to extract high rate position and heading data from the
raw POSPac files. Once the 4125 data were converted in CARIS, the lower frequency fixed-
mount SSS fish position and heading logged to the JSF file was replaced with the high rate
position and heading data extracted from the POSPac files using the Generic Data Parser Tool
in CARIS HIPS/SIPS.
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A.8.2.14 Global Mapper

This 3-D visualization software and geographic information system was employed to create
detailed sun-illuminated Digital Terrain Model (DTM) images, display vector geographic data
and convert file formats. These data were used for QC checks and presentation purposes.

A.8.2.15 AutoCAD 2004

AutoCAD drafting and geographic information system was employed for pre-survey planning,
line file construction, hydrographic data QC and the production of presentation graphics.

A.8.2.16 Hydrographic Consultants, Ltd. CALLOAD

CALLOAD was installed on the HYPACK acquisition computer and used to calibrate and
configure the SCC Smart Cable Counter. Sheave circumference, quantity of magnets and
preset cable out values were input into CALLOAD to reset the cable counter. Once the
hardware had been configured via the CALLOAD software the “cable out” value was reset, as
needed, by means of hardware controls, i.e. buttons on the cable counter display unit. This
process was completed frequently throughout side scan sonar operations between data
acquisition runs.

A.8.2.17 Trimble ProBeacon

The Trimble ProBeacon PC interface program was installed on a utility laptop computer and
used to configure the Trimble ProBeacon to receive DGPS correctors from the selected USCG
station. The PC Interface Program was run through a DOS command window to enter the
receiver frequency, check the receiver status and monitor the RTCM messages.

A.8.2.18 Trimble GPS Configurator

The Trimble GPS Configurator software was installed on a utility laptop and used to configure
the Trimble 5700 Receiver. The software is a menu-driven Windows program that was used
to configure the RTK GPS base station (used for pre-survey calibrations). This software is
also used to monitor system status and start/stop internal logging the results of which were
submitted as RINEX-format files to the National Geodetic Survey’s Online Positioning User
Service (NGS OPUS).

A.8.2.19 NGS OPUS-RS

The NGS’ online OPUS-RS software was used to transform dual-frequency GPS observables,
recorded with the Trimble 5700, into what the NGS describes as “high—accuracy National
Spatial Reference System coordinates.” The resultant coordinates were used as local reference
points against which the survey vessel’s POS MV DGPS position solution accuracy was
verified during port stops throughout the project.
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A.8.2.20 Sea-Bird Electronics Programs

Seasoft for Waves and Seaterm V2 were used to communicate with and configure the pressure
gauges and conductivity sensors which comprised the BMPG packages. Upon retrieval these
programs were uses to download the recorded data and, importantly, used to confirm any
instrument time drift that occurred during the period of the deployment. The minor time drift

noted during download was corrected during data processing.

A.8.2.21 Acquisition System Block Diagram
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B. QUALITY CONTROL

B.1 Data Acquisition

All data acquisition and processing were performed under the supervision of the Chief of Party.
Field acquisition was performed under the supervision of a Lead Hydrographer and a Senior
Hydrographer, each with well over three years of experience conducting hydrographic surveys.

Prior to the survey, a review of the current charted data was conducted to identify critical
features and areas including platforms, obstructions and wrecks. The Composite Source File
(CSF) and Project Reference File (PRF) supplied by NOAA were included in this review.

Line plans were created to achieve 100% SSS coverage with concurrent MBES, with lines
planned for side scan acquisition as follows:

e 75-meter SSS range — 130-meter line spacing resulting in 20 meters of outer range
overlap; SSS nadir coverage provided by the MBES

e 50-meter SSS range — 80-meter line spacing resulting in 20 meters of outer range
overlap; SSS nadir coverage provided by the MBES

e In reaches of the survey area inside (shoaler than) the preliminary 5.5 meter (18 foot)
MLLW contour the 80-meter line plan noted above was supplemented with a “splits”
line plan which equated to an effective 40-meter line plan within the area. The SSS
range was maintained at 50 meters for both mainscheme and splits lines inside the 18
foot MLLW contour. Only Sheet H12906 had depths <18 feet MLLW.

Data acquisition quality control procedures were established and performed to ensure survey
data met requirements specified in the SOW and HSSD.

B.1.1 Bathymetry: Multibeam Echosounder (MBES)

Transducer offsets for the Reson 7125 were measured relative to permanent shipboard
benchmarks and to the vessel reference position (RP) using a steel tape measure. The
benchmarks were established during the 2015 full static survey of the R/V Ocean Explorer
which was completed using standard optical survey equipment and techniques. The transducer
mounting orientation as relates to the vessel’s fore/aft centerline and the POS MV IMU
orientation was set, in 2015, using a portable gyroscopic compass mounted on a square plate.
In practice, the vessel was secured to a fixed dock on a calm day with engines ahead pulling
the dock lines taut. At this time the transducer pole was rotated until the heading of the
transducer matched the physical heading of the POS MV IMU. The gyrocompass was passed
back and forth multiple times to confirm that the orientation of the IMU matched the
orientation of the transducer. At this time index marks were permanently scribed into both the
transducer pole and vessel attachment point such that the initial transducer orientation could
be reliably repeated if it was necessary to move the transducer pole, e.g. to accommodate a
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draft change. These permanently scribed index marks were used to accomplish the initial
alignment during the 2016 mobilization. A patch test was then used to determine minor
residual misalignments between the transducer and the POS MV IMU. As regards the
attachment and alignment of the entire transducer mounting system, apart from retracting the
pole for transit, once the draft and alignment were set during mobilization no changes were
made for the period of the survey. As mentioned earlier, daily roll check patch test results
indicated that the multibeam pole was stable for the period of the survey.

The POS MV IMU “bullseye” or reference point, located on the top of the IMU served as the
vessel RP. The IMU mounting plate and key components of the transducer pole mounting
apparatus are permanently installed hardware components of the survey vessel. For detailed
information regarding system offsets refer to Section C Correction to Echo Soundings.

The Reson 7125 processor was interfaced with the POS MV such that UTC date and time
information from the POS MV was used to accurately time stamp the Reson output data string.
The Reson 7125 processor received a pulse-per-second (PPS) signal and a serial $ZDA NMEA
timing string from the POS MV. The POS MV also supplied a “TSS1” message to the Reson
TPU allowing for real-time roll stabilization. Surface sound speed recorded at the transducer
head with the AML Micro-X was output to the Reson 7125 processor to be used in beam-
forming. The 7125’s “Normal” filter was used for sound speed filtering. Raw sounding data
were output from the Reson 7125 TPU to the HYPACK acquisition computer via an Ethernet
connection.

The POS MV received DGPS correctors from a Trimble ProBeacon. POS MV position,
heading and attitude data strings were output to the HYPACK acquisition computer via an
Ethernet connection.

HYPACK SURVEY and HYSWEEP SURVEY were configured to record position, heading,
attitude and depth to RAW and HSX data files. For the real-time display, system offsets for
the IMU and for the transducer phase center were entered into the HYPACK configuration
files. These offsets were subsequently incorporated into the CARIS data processing routine.

Prior to the start of data collection using the Reson 7125 and in light of physical offsets derived
during the 2015 full static survey, the vessel static draft was measured and the transducer draft
was confirmed by means of a “bar check” while alongside a dock. The bar check procedure
consists of lowering the lead line disk to various indexed depths (calibration points) directly
below the multibeam transducer and recording the nadir depth value output from the Reson
7125 as returned from the acoustic target. A “spot check” was also completed which consisted
of sounding the seafloor directly below the multibeam transducer with the lead line while
simultaneously observing the multibeam nadir depth. Throughout the course of the survey bar
checks were completed at least weekly. All bar checks and spot checks indicate that the
multibeam sonar system was performing within expected accuracy limits (DAPR Appendix
10).
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The initial vessel and MBES calibration to establish the dynamic draft correction table (squat
test), residual transducer alignment offsets (patch test), and a multibeam system performance
test were completed on July 27, 2016 (DN 209). These tests were performed with the POS
MYV in RTK GPS mode as a land based RTK GPS base station was established for this purpose.
These data were collected nearby the vessel’s home port once the vessel was mobilized and
physical offsets derived. This patch and performance test data were only utilized for system
acceptance testing.

After transiting to the project area a second set of patch test and performance test data were
acquired. Specifically, patch test data were acquired in the Atchafalaya River on August 16,
2016 (DN 229) with the POS MV in RTK mode as the test area was within range of a RTK
GPS base station deployed by OSI. The performance test was completed within the assigned
survey area on August 25, 2016 (DN 238) with the POS MV in DGPS mode. These datasets
serve as the project start “calibrations of record.”

A “closeout” patch test and performance test were completed in the Atchafalaya River at the
completion of the project to ensure that the transducer alignment and system performance
remained consistent over the course of the survey. This testing was done on September 30,
2016 (DN 274) with the POS MV in RTK GPS mode; a local GPS base station was again
deployed for this purpose. Calibration results are presented in Section C. Correction to Echo
Soundings.

The SeaBat display and user interface installed on the Reson 7125 TPU were used to configure
MBES settings, to monitor sounding acquisition, and to adjust system parameters in real time.
The Reson 7125 was operated in equidistant mode using 512 beams. As mentioned previously
the system is capable of operating in equidistant mode with a swath of 140°. However, the
swath was reduced to 130° for all project data acquisition due to observed degradation of data
quality in the outer beams (beyond 65°) caused primarily by dynamic changes in the sound
speed profile. The roll stabilization feature was activated throughout the term of the project.
“Absolute” depth gates were conservatively employed to reject fliers during mainscheme and
cross line data acquisition. Depth gate filters were used sparingly or turned off all together
during item investigations.

The Reson sounding profile “wedge” was monitored in real time. Power and gain settings
were monitored and adjusted to optimize bottom detection. Range settings were monitored
and adjusted for observed depths to maximize the ping rate.

Bathymetry, position, motion and heading data were logged in HYPACK SURVEY and
HYSWEEP SURVEY. Position information from the primary and secondary GPS receivers
(POS MV and Trimble SPS 461) were continuously compared in HYPACK SURVEY and
status indicators were monitored in real time. By means of a utility in the HYPACK SURVEY
program a position disparity between the primary and secondary positioning systems that
exceeded two (2) meters would be reported by means of a visual alarm on the data acquisition
screen.
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The HYSWEEP SURVEY program allows for real-time monitoring of surface sound speed as
transmitted by the transducer-mounted AML Micro-X. A utility in HYSWEEP SURVEY
allows for real-time comparison of the Micro-X-reported surface sound speed to the surface
sound speed recorded in the most recently acquired water column sound speed profile (as
reported by the ODIM MVP). For this project the system was configured to provide a visual
alarm if the difference between these surface sound speed values exceeded 2 meters per second.
Hydrographers endeavored to acquire sound speed casts at an interval of < 15 minutes.
However, when a dynamic surface sound speed was noted, sound speed profile casts were
acquired more frequently.

In HYSWEEDP, real-time MBES sounding wedge and digital terrain model (DTM) waterfall
displays were monitored. The sounding wedge, DTM waterfall, and plan view coverage
displays were corrected for draft, motion, predicted tides and sound speed. Survey coverage
was tracked in the HYPACK SURVEY display window with a matrix file updated in real time.
MBES survey line names were composed of the year, vessel, day number, UTC time and line
number, for example: 20160C2470423 7116.HSX/RAW, where “OC” stands for Ocean
Explorer.

The POSView software was used to monitor position, heading and motion accuracy status
indicators. Applanix “TrueHeave” data (included in POSPac data) were acquired and recorded
during survey operations. The TrueHeave algorithm uses a delayed filtering technique to
increase heave measurement accuracy, reducing error caused by IMU drift and long-period
ocean swell. In most cases POSPac data were logged at least 5 minutes prior to and after
MBES acquisition. POSPac TrueHeave file names include the project number, device (POS
MYV), day number, and month/day (ex: 16ES023 POS DN247 0903.000). POSPac files were
saved in individual day folders. Once the file size reached 64 MB, a new file was created;
therefore, each day of survey has multiple TrueHeave files.

The POS MV heave bandwidth filter was configured with a dampening ratio of 0.707. The
cutoff period of the high-pass filter was determined by estimating the swell period encountered
during the project. A heave bandwidth filter of 10 seconds was employed for project OPR-
K354-KR-16 data collection.

During the daily “UTC midnight” changeover, the vessel was stopped and a number of
mandatory and/or elective QA/QC functions performed: a static draft physical measurement
was obtained (conditions permitting), a transducer pole stilling well pressure series was
acquired and processed into a static draft value (conditions permitting), a new Applanix
POSPac/Trueheave file was begun, a bar check was performed (weekly) to verify echosounder
draft offsets and system sounding accuracy, a sound speed profile comparison cast was
performed nearly daily, and side scan sonar depth sensor function/accuracy was confirmed (as
appropriate). A surface sound speed comparison (AML Micro X vs. ODIM MVP) was
recorded at this time via the Velocwin “Daily Comparison” utility. However, if conditions
were too rough to make the aforementioned static vessel tests impractical, the vessel was kept
underway and the surface sound speed “Daily Comparison” was performed while underway.
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Data were copied, via network connection, onto a shipboard data backup computer which also
served as the data QA/QC platform. Data were copied from this computer to removable media,
2-TB USB drives, frequently throughout each survey day. These data were periodically
transferred to OSI’s home office via courier delivery.

B.1.2 Imagery: Side Scan Sonar

For the towed SSS configuration, prior to commencing survey operations, the location of the
top of the side scan sonar sheave at its operational, deployed position was verified with respect
to the vessel RP. The vertical offset between the SSS sheave reference point and the water line
was also confirmed. The position of the sheave serves as the starting point for the cable out
measurement used to calculate towfish layback. In practice, horizontal offsets entered into the
HYPACK SURVEY data acquisition program (used to calculate towed fish position) were
measured relative to the survey vessel “steering point” origin which was able to be accurately
related to the vessel RP.

For the fixed mount side scan sonar configuration, the horizontal position of the SSS was
measured in relation to the vessel RP. However, as with the towed configuration, horizontal
offsets entered into the HYPACK SURVEY data acquisition program (used to calculate fixed
mount fish position) were referenced to the survey vessel “steering point” origin which was
able to be accurately related to the vessel RP.

As discussed previously, EdgeTech Discover side scan sonar acquisition software was used to
log the SSS imagery and position information in JSF file format. Both instances of Discover
received towfish position from HYPACK SURVEY and, in the case of the fixed mount system,
ship heading, directly from the POS MV. SSS survey line names include date (YYYYMMDD)
and UTC time (HHMMSS), for example: 20160903042354.jsf.

Over one hundred percent (100%) SSS coverage was attained employing line spacing and side
scan sonar range scales tabulated in Table 4 below.

Table 4
SSS Line Spacing and Range Scales

Trackline Offset SSS Range Scale
(meters) (meters)
80 50
130 75

Vessel speed was maintained such that any 1 m> objects would be ensonified more than three
times per pass at the operating range scale.

For the towed SSS configuration, cable out readings were verified and/or recalibrated at least
once per survey line by observing measured index marks on the towfish cable with respect to
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the reference position at the top of the sheave. The calculated depth from the pressure sensor
within the EdgeTech 4200-MP towfish was confirmed regularly throughout the survey day.
The 4200-MP’s pressure sensor was not observed to drift throughout the term of the survey.
However, the pressure sensor on the first 4200-MP employed on the survey failed just a few
lines into data acquisition. The effected data were rejected. A replacement 4200-MP towfish
was employed to complete the remaining towed SSS work.

For the fixed mount configuration, the 4125 SSS towfish height was not adjustable. As such
the towfish altitude varied based on water depth. Therefore, on any given trackline, the SSS
altitude may have been marginally below the 8-20 percent range scale limit, i.e. at times the
altitude was less than 4-meters which is the shallow limit when using the 50-meter range scale.
As mentioned previously, 40-meter splits lines were run in the shallow reaches of Sheet
H12906 which is the only area in which the low altitude threshold was exceeded. By splitting
the lines in this area, the 100% SSS coverage requirement was far surpassed despite the 12.5x
water depth SSS swath cutoff rule. Due to the relatively shallow water depths in these areas,
the fixed mount SSS was used exclusively in Surveys H12905, H12906, and H12907. The
4125 SSS was used sparingly in Survey H12908 as water depths were generally deeper in this
sheet requiring use of the towed 4200 SSS.

The towed fish height was adjusted to fly at 8-20 percent of the range scale, with a visual alarm
setup to indicate when the fish was nearing the upper and lower limits of the height threshold.
Refraction and surface noise effects were minimized by changing the depth/altitude at which
the towfish was flown. The towed SSS (4200-MP) was only used in Survey H12908.

As a conservative measure, for both the towed and fixed-mount SSS systems, in order to only
utilize the effective SSS swath range, all sonar imagery was trimmed to 12.5 times towfish
height before being mosaicked. Due to the conservative SSS line spacing described above,
100% coverage was still easily accomplished.

Confidence checks observed across the full range (e.g. scour marks and bottom type changes)
were recorded frequently throughout each survey day to verify system operation and object
detection capabilities. Confidence checks were recorded with line names, observation times, and
comments in the daily acquisition log. On occasion, due to a weather or port call-shortened
survey day, it was difficult to record a confidence check if the bottom in the area of operation
was particularly devoid of texture or features. In these cases the survey vessel was navigated
away from the survey area to record a confidence check at a previously identified “known”
feature.

Approximate vessel speed for SSS acquisition was 7-9 knots.
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B.1.3 Sound Speed
B.1.3.1  Sound Speed Profiles

Sound speed profile data were acquired with the ODIM MVP30 approximately every 15
minutes, except when this time interval occurred while the vessel was turning. The MVP
operator acquired casts more frequently if high variability was noted in the surface sound
speed, prompted when the surface sound speed alarm threshold was exceeded (> 2
meters/second change). Profiles were acquired to a depth approximately 0.8 to 1 meter off the
bottom when operating in freewheel mode. For the overwhelming majority of sound speed
casts the MVP free fall fish reached a depth greater than 80% of water depth. At least once
per day the MVP fish reached a depth of at least 95% of water depth. As a safety measure,
there were occasions that the free fall fish did not make it to within 80% of the water depth,
e.g. in very shallow reaches of the survey area or in the vicinity of charted or observed
obstructions. All casts were acquired within the survey area. The moving vessel profiler was
operated in accordance with the ODIM Brooke Ocean’s MVP30 Operation and Maintenance
Manual.

The ODIM MVP Controller software was configured to receive navigation data from
HYPACK via the MVP.dll. HYSWEEP SURVEY was configured to receive MVP casts in
real time to correct the real time waterfall and profile displays with the most recent sound speed
profile. MVP cast position, sound speed and depth data were recorded in .CALC file format
and saved to the designated MVP laptop computer. Profiles were named for day number and
cast number, for example: MVP_DN247 0018.calc.

Frequently during the daily “UTC midnight” changeover, while the R/V Ocean Explorer was
at a full-stop offshore, the MVP was manually deployed to full seafloor depth while an AML
Oceanographic Base-X sound speed profiler was simultaneously deployed for a comparison
cast. This satisfied the HSSD-specified “independent sound speed measurement system
confidence check” requirement. AML Base-X comparison casts were used for quality
assurance only and were not utilized in sound speed correction of soundings.

B.1.3.2  Surface Sound Speed

The AML Micro-X sound speed sensor was installed within the bow fairing of the multibeam
transducer essentially at the draft of the transducer phase center. Real-time surface sound
speed values were transmitted to the Reson 7125 topside unit and subsequently recorded with
multibeam echosounder data in the raw HYPACK .HSX data files. Sound speed data were
also utilized by HYSWEEP SURVEY which was configured to display a visual alarm if the
surface sound speed changed +/- 2 m/s. Variations in surface sound speed were monitored and
evaluated as an indicator of surface water temperature/salinity fluctuation and potential water
column variation which would necessitate additional sound speed profile measurements.
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Daily sound speed quality assurance (DQA) checks were performed using NOAA’s Velocwin
software by comparing the AML Micro-X surface sound speed to the surface sound speed of
a MVP manual cast (stopped offshore) or an automated cast (underway).

B.14 Horizontal and Vertical Control

The U.S. Coast Guard (USCG) Differential GPS (DGPS) station in English Turn, LA served
as the primary horizontal position control and USCG station in Angleton, TX served as the
secondary horizontal position control. The POS MV primarily received pseudo range
corrections from the English Turn station. However, the Angleton, TX signal was used when
the English Turn Signal was unavailable or degraded due to thunderstorm activity between
English Turn and the survey boat.

Prior to the start of survey operations, navigation checkpoints were established at the vessel’s
Louisiana base of operations employing a Trimble 5700 with a Zephyr geodetic antenna. Dual-
frequency GPS observations were recorded at two dockside locations to help ensure vessel
access during the course of the survey. The vessel was always able to secure next to the
primary checkpoint; therefore, only this checkpoint was ultimately utilized. The dual-
frequency GPS observables were submitted to the National Geodetic Survey’s (NGS) On-line
Positioning User Service (OPUS) and processed to determine the positions of the temporary
control points. NGS provided an OPUS Report which included both ITRF and NAD&3
coordinates along with position accuracy information. These reports are provided in the
Horizontal and Vertical Control Report (HVCR).

Position confidence checks of the POS MV were accomplished at the start of survey and during
provisioning stops in Morgan City, LA. The distance between the vessel reference point and
the horizontal control point computed by the navigation system was compared to the distance
between the vessel reference point and the horizontal control point as measured with a steel
tape. In all cases, dockside navigation system accuracy testing demonstrated that the POS MV,
employing USCG correctors (from either source mentioned above), had an accuracy of better
than 1.0 meter. A tabulation of navigation system performance checks is included in DAPR
Appendix III.

A HYPACK SURVEY “position integrity alarm” was utilized throughout the term of the
survey. In practice the utility continuously compared independent positioning sources, i.e. the
position reported by the POS MV to the position reported by the Trimble SPS 461. For the
purposes of the comparison the physical, shipboard position of the SPS 461 antenna was related
to the RP (POS MV IMU) via forward and starboard offsets in HYPACK SURVEY. The
position solution difference, expressed in meters and viewed on a window on the HYPACK
SURVEY display, was monitored by the acquisition team. An on-screen visual alarm notified
the system operator if the difference in positions exceeded 2-meters.

The alarm threshold was rarely exceeded. The alarm proved valuable in quickly drawing
attention to the DGPS beacon status when a station went offline or had a degraded signal.
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During data acquisition, the MV-POSView controller software was used to monitor real-time
position accuracy, with the accuracy alarm set at 2.0 meters.

Per the Project Instructions, water level data from NOS-NOAA Tide Station 876-4227,
LAWMA, LA was used for vertical control. Predicted tide files were downloaded from the
Center for Operational Oceanographic Products and Services (CO-OPS) website,
http://opendap.co-ops.nos.noaa.gov/axis/text.html, prior to survey operations. Predicted tide
files were used during preliminary processing. Preliminary tides from the LAWMA station
were downloaded and reviewed for data gaps. Verified tides were downloaded and reviewed
when available.

Two bottom mounted pressure gauges were deployed in the southwest corner of the project
arca. Per CO-OPS, water levels recorded at this location could be used to better understand
tidal propagation and the error associated with the LAWMA station tidal zoning. In fact,
regarding tide component error estimation, the Tides and Water Levels Statement of Work
states that, “there is insufficient data with which to perform an accurate error estimation.”

OSTI’s tides subcontractor, JOA Surveys, processed the recorded BMPG data, performed an
instrument “settling analysis”, and incorporated datum-corrected offshore tide data into an
analysis of the CO-OPS provided zoning. JOA Surveys’ analysis indicated that the preliminary
zoning did in fact require adjustment. JOA Surveys’ modification of the preliminary zoning
retained the preliminary zone shapes but modified range ratios and time correctors for each
zone.

The BMPG tide data, analysis, and report were transmitted to CO-OPS via e-mail and FTP
link on November 9, 2016. The BMPG analysis and zoning modification report is included
with the project deliverables.

Final project data are delivered with verified tides applied using the modified zoning file
“K354KR2016RevisedZoning20161103.zdf”. The preliminary zoning file,
“K354KR2016CORP.zdf” is also included in the deliverables.

B.1.5 Feature Verification

When necessary, development/investigation MBES only lines were run over significant
contacts and other features observed in MBES and SSS records to determine a least depth and
to meet the Object Detection Coverage specification in the HSSD (Section 5.2.2.2). During
home office processing, once an item was deemed significant, nearly significant, or simply
required more data to make a determination, the contact or outstanding sounding position was
conveyed to the field team in various formats including:

An EXCEL tracking table that was added to the acquisition log
a HYPACK target file of point items

an AutoCAD-compatible .DXF file for area features

a HYPACK line file (.LNW) for SSS or MBES fill in areas
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A series of short MBES lines were run over the feature from multiple directions to obtain
soundings on the object at various angles with high sounding density.

Given that the SSS coverage requirement for this project was 100% (as opposed to the
traditional 200%) there were many instances where the first pass, single SSS coverage was not
sufficient for data analysts to confidently describe the nature of a particular feature.
Furthermore, the shadowing effect of items such as oil platform legs, dense fish schools, etc.
resulted in data gaps that might otherwise have been ensonified with the second coverage
afforded by the traditional 200% coverage requirement. These data gaps were identified during
home office data processing and conveyed to the field team via the various methods bulleted
above. All such data gaps were eventually filled with 200% SSS coverage or Complete MBES
coverage while the field team was still mobilized.

B.1.6 Bottom Sampling

Bottom samples were acquired in close proximity to the recommended positions included in
the PRF provided with the OPR-K354-KR-16 Project Instructions. A sediment sampler was
deployed from the A-frame located on the stern of the vessel to acquire seafloor sediment
samples. Bottom sample locations were logged in a target file in HYPACK SURVEY. Once
the sample was on deck it was photographed and classified based on the criteria outlined in
Appendix H, Bottom Classification, in the HSSD.

B.1.7 Other
B.1.7.1  Autopilot

The Simrad AP50 Marine Autopilot was configured to receive heading from the POS MV, and
speed, position and the Autopilot (APB) message from HYPACK. Once in control, the
Autopilot maintained the vessel steering point within approximately 2 meters of the selected
trackline.

B.1.7.2  Digital Acquisition Logs

An acquisition log was maintained in Microsoft Excel to record all pertinent information
related to acquisition, such as:

Daily operations and locations

Weather and sea state observations

MBES and SSS survey line ID and start time

Date and Time of MVP and TrueHeave (POSPac) files

Navigation System Performance Checks, Bar Check Table, Vessel Water Level
Tabulation and Sound Speed Comparison Table

e Systematic changes (i.e. SSS range scale change, equipment repairs or replacements)
e SSS Confidence Checks

e Significant SSS contacts or Bathy features
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Excessive Noise in the SSS/MBES records due to fish, vessel traffic, or surface noise
Deviations from planned tracklines or Data Gaps

System “crashes” or Position Outages

Line Miles and Survey Statistics

Item investigations

B.2 Data Processing
B.2.1 Bathymetry
L. Data Conversion and Preliminary Sounding Correction

QA/QC level processing was completed onboard the survey vessel; however, all formal data
processing occurred at OSI’s home office. In practice, data disks were shipped via courier to
the home office processing center during port calls. Using this approach the lag between
acquisition and data check-in at the home office was about one week except near the end of
the field program where more frequent port calls and high speed (land based) FTP transfer of
critical files was accomplished. Upon receipt of a data disk (or FTP download), information
contained in the daily acquisition log was compared to the data package to ensure that no files
were lost or omitted. Prior to data processing the acquisition log was consulted to verify line
names and file size and to remove any aborted lines from the preprocess folder prior to
converting the data in CARIS HIPS. All accepted MBES & SSS line data, POS MV
TrueHeave files, and MVP sound speed profiles were entered into the survey processing log,
which was used to track the processing progress of each line and to enter all notes pertinent to
individual lines or days. The processing log was built from the acquisition log in that any
pertinent information regarding accepted line data was propagated from the acquisition log.

Vessel configuration files (HVFs) were created in CARIS HIPS Vessel Editor prior to data
conversion. The HVF files contained transducer offsets relative to the RP, alignment offsets
derived from the calibration testing, as well as the waterline height and standard deviation
values for all surveyed parameters (used to model sounding uncertainty). Duplicate HVFs
were created for the MBES system to convert lines into HDCS folders according to
classification, i.e. mainscheme lines, cross lines, investigation lines. Waterline correctors were
updated in the HVF files as new values became available. See Section C Corrections to Echo
Soundings for additional information regarding vessel configuration files.

Multibeam sonar data conversion and application of sounding correctors were completed using
the CARIS HIPS Batch Processor. The Batch Processor runs a user-defined script which
accomplished the following standard tasks in succession:

1. Convert the HSX and RAW data to the HDCS data format.
2. Load zoned, preliminary or verified tides, if available.
3. Load daily TrueHeave files.
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4. Load and apply concatenated sound speed profile data. Sound speed profiles were
loaded with the CARIS nearest in distance within time correction method. During

CARIS SVP Correction, the following correctors were applied: sound speed, heave,

pitch, roll and waterline.

Merge data to apply vessel offsets/alignment, position, gyro, tide, and dynamic draft

correctors to bathymetry. HIPS/SIPS computes the fully corrected depth and position

of each sounding during the Merge process.

Compute TPU (Figure 7). Total Propagated Uncertainty (TPU) is calculated in CARIS

HIPS from contributing uncertainties in the echosounder, positioning and motion
sensor measurements as well as uncertainties associated with sound speed and water
level correction. The standard CARIS devicemodel.xml was used to create the HVF.

Tide uncertainty values for measured and zoned tides were not provided in the OPR-
K354-KR-16 Tides Statement of Work. Rather, JOA Surveys’ BMPG offshore “tide
data” analysis suggests that a zoning uncertainty value of <0.18 meters at the 95%
confidence level is appropriate. The tide values shown in the figure below were based
on error values reported in OPR-K354-KR2016 Zoning Report.pdf, with a combined
reference station error of 0.03 m and a maximum zoning error of 0.09 m, with the 0.18

meter uncertainty reported at lc.

Sound speed TPU values were estimated from manufacturer accuracy of the ODIM
MVP30 and AML Micro-X and from guidance in the OCS Field Procedures Manual
(FPM) Appendix 4 under CARIS HVF Uncertainty Values. The MVP was deployed
for a cast at a frequency of <15 minutes. As such a sound speed profile uncertainty
value of 1 m/s was chosen for the measured sound speed. A conservative value of 1
m/s was chosen for the sound speed surface uncertainty despite the fact that the surface
and near surface sound speed profile gradient was relatively uniform throughout the

period of the survey.

Compute TPU

Survey spedfic parameters

Tide values:

Measured

0.03

m

Zaning m

Sound Speed values: Measured | 1000 | mfE  Surface| 10000 | mfs
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Compute
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Figure 7. Uncertainty values entered into the Compute TPU process in CARIS HIPS

& SIPS.
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II. Preliminary BASE Surfaces

Preliminary field sheets and Bathymetry Associated with Statistical Error (BASE) surfaces
were created for reviewing and cleaning full-density soundings using the Combined
Uncertainty and Bathymetry Estimator (CUBE) process. Daily data review and cleaning were
performed using 1-meter resolution CUBE surfaces as a guide for directed editing. Due to
water depth and in consideration of coverage requirements defined in the Project Instructions,
the survey was completed employing only two types of MBES coverage methodologies:
Complete Multibeam according to the HSSD Section 5.2.2.3 - Option B approach and Object
Detection. Depending on the MBES acquisition methodology employed and in consideration
of water depth, various CUBE surfaces were created to evaluate coverage, e.g. l-meter
resolution CUBE for “Complete Multibeam” MBES coverage or 2-meter resolution CUBE for
“Complete Multibeam” in water depths greater than 18 meters. Both in the field and during
home office processing, 0.5-meter resolution CUBE surfaces were used to evaluate coverage
for item investigations.

After the lines were run through the batch process, they were added to the 1-meter Cleaning
surfaces and the appropriately gridded Coverage surfaces. Depth, Standard Deviation and
Shoal surface models were viewed with sun illumination and/or vertical exaggeration to
highlight areas that would require immediate investigation. Standard deviation surfaces were
reviewed to evaluate data for consistency between overlapping coverage and cross lines, and
to detect potential systematic position, motion, tide, or sound velocity errors. Highest standard
deviation values were observed over obstruction features, seafloor depressions, in the vicinity
of offshore platforms and, due to wind setup affecting application of zoned tides, at certain
instances of overlapping/crossing data where one or more crossing lines were acquired during
periods of relatively high wind.

Coverage surfaces were reviewed for any data gaps meeting the criteria described in HSSD
Sections 5.2.2.2 and 5.2.2.3 respectively. All surfaces were reviewed to ensure that Object
Detection Coverage was obtained over significant shoals and features. Density layers were
reviewed to verify that 95% of all nodes in the Object Detection and Complete Coverage
surfaces were populated with at least 5 soundings.

III.  Data Cleaning and Processing

Line attitude and navigation data were reviewed in their respective CARIS editors to ensure
that there were no problems with the correctors, such as gaps in attitude data or navigation
jumps.

The CARIS Swath Editor was used to clean noise, multipath returns, and gross fliers which
are most easily reviewed and edited in this time-based (ping) display. Soundings were colored
by depth and reviewed in multi-directional profile and plan view displays. Tracklines and
swath boundaries were viewed in the CARIS Map window in reference to BASE surfaces,
charted data (RNC/ENC), SSS contacts and field annotations (HYPACK target files).
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The CARIS Subset Editor was used to clean fully-corrected, geospatially located soundings in
2-D and 3-D displays. Soundings were primarily colored by line to verify the validity of bathy
features or SSS contacts recorded by multiple MBES passes and to reject fish or water column
noise recorded in one MBES pass and disproved by overlapping coverage from a different
MBES line. Areas with multiple sounding coverages from adjacent survey lines were
evaluated to increase confidence in outer beams and over significant features. Subset
boundaries were viewed in the CARIS Map window in reference to BASE surfaces, charted
data (RNC/ENC), and SSS contacts. A complete final sounding review was performed for the
entire survey coverage area using Subset Editor and tracked with subset tiles.

Full density soundings were reviewed for each SSS contact in the CARIS Subset Editor and a
sounding was designated for the representative least depth of significant contacts.

“Outstanding” sounding flags were temporarily assigned to soundings on features, or possible
features, which required further review. Occasionally a request would be sent to the field crew
asking for additional coverage on the feature for clarification. Before finalizing the survey, all
Outstanding soundings were reviewed and resolved, then either marked as “Accepted” or
“Designated” as appropriate. No soundings were left with an “Outstanding” flag.

The Designated flag was used to identify the least depth of a feature and ensure that the least
depth would be represented in the finalized CUBE surfaces. When a designated sounding was
assigned to a feature, it indicated that no further investigation was required. OSI followed
Section 5.2.1.2.3 of the HSSD guidance on the criteria for choosing designated soundings.
Near nadir soundings were designated as least depths on features in lieu of outer beam
soundings whenever possible. In the instance that soundings from multiple MBES lines
suggested different least depths, the contact heights measured in side scan editor were reviewed
to assist with least depth designation and the near nadir soundings favored over outer beam
soundings.

Once the surface deliverables were finalized, chart comparisons were completed with the
surveyed depths and charted depths located on all affected Raster Nautical Charts (RNCs) and
Electronic Nautical Charts (ENCs). The final chart comparison was completed using charts
downloaded from the OCS website, nauticalcharts.noaa.gov, on December 19, 2016. CARIS
Notebook and CARIS HIPS & SIPS were utilized to complete chart comparisons with the
affected RNCS and ENCS. This was accomplished by overlaying surveyed depths in the form
of finalized surface layers, sounding layers and S-57 features over the RNCs and ENCs.
Surveyed data were compared to all charted depths, contours and features, with agreements,
discrepancies and disprovals addressed in each survey’s descriptive report and final feature
file.
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B.2.1.1  Methods Used to Maintain Data Integrity

All project raw data files were copied onto the onboard QA/QC processing computer. The
hard drives on the processing computer retained both the raw and QA/QC-processed data. Raw
data on the QA/QC processing computer were backed up to a removable, 2-terabyte, USB-3
hard drive numerous times each day. During each port call the removable hard drive was
shipped to OSI’s home office. The removable drive was packaged for shipping only after a
redundant, fully populated backup had been placed in service onboard the vessel.

B.2.1.2  Methods Used to Generate Bathymetric Grids

After MBES sounding editing was complete, final BASE surfaces were created using the
CUBE algorithm as incorporated in CARIS HIPS and SIPS. The CUBE algorithm generates
surface models from multiple hypotheses that represent the most accurate possible depths at
any given position. Hypotheses with lower combined Total Propagated Uncertainty (TPU) are
given higher significance for incorporation into the final surfaces. Also, soundings closest to a
grid node have a greater weight on the node depth value than soundings that are further away.

The following options were selected when final CUBE surfaces were created:

Surface Type — CUBE

IHO (International Hydrographic Organization) S-44 Order la
Include Status — Accepted

Additional Attributes — Shoal and Deep

Disambiguation Method — Density & Locale

CUBE parameter configuration varied with surface resolution. The CUBE parameters Capture
Distance Scale and Capture Distance Minimum were modified according to grid resolution to
meet the requirement that the maximum propagation distance for a node shall be no more than
the grid resolution divided by the 2.

The Capture Distance Scale (CDS) defines a radial distance from the node which is based upon
a percentage of water depth. All soundings within this radius are included in the Density value
and propagated to the node.

The Capture Distance Minimum (CDM) defines a fixed radial distance in meters from the node
in which all soundings are included in the Density value and propagated to the node.

During CUBE surface creation, the maximum value of the two capture distance parameters is
used to set the actual capture distance. To ensure that the CDM was the determining factor for
the radius of influence for each node, a CDS value of 0.50 % was used for the creation of all
surfaces.
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Example for a 1-meter BASE surface in depths less than 20 meters:

CDS = 0.005
CDM =1/ (\2)=0.707

The CDS radius maximum value (0.005 * 20 = 0.1 meters) will not exceed the CDM value
(0.707 meters) for the maximum depth, and therefore the Density Attribute Layer will represent
those soundings that lie within a fixed radial distance (0.707 meters) for all nodes.

Table 5 displays the CDS and CDM values entered for the grid resolutions used.

Table 5
CUBE Parameters Applied in Surface Generation

Grid Resolution

Capture Distance

Capture Distance

(m) Scale (%) Minimum (m)
0.5 0.5 0.35
1.0 0.5 0.71

Complete Multibeam Coverage requirements in Section 5.2.2.3 of the HSSD prescribes a grid
resolution threshold of 1 meter to prove MBES coverage in water depths less than 20 meters.
Project Instruction Coverage Requirements are included below:

e Complete Coverage accomplished using either A) Complete coverage MBES depth and
backscatter data, or B) 100% SSS coverage with concurrent set line spacing MBES
depth and backscatter data. Refer to HSSD Section 5.2.2.3 and 6.2.

Keeping in mind the following, Complete Multibeam grid resolution, node density, and holiday
definitions were used as a guide in preparing deliverables for this survey. HSSD Section 5.2.2.4
explicitly states that, “neither 200% SSS with concurrent multibeam, nor 100% SSS with
concurrent multibeam are considered a “Set Line Spacing” survey as they respectively define
Object Detection and Complete Coverage standards”.

All significant features were developed with MBES to meet Object Detection coverage
standards. Object detection surfaces were centered over the significant features and covered

an approximate area of 400 m?.

The attributes associated with each grid node are as follows:

Depth Value

Uncertainty

Standard Deviation

Mean, Deep and Shoal Depths

Sounding Density

CUBE Surfaces: Hypothesis Count, Hypothesis Strength & User Nominated
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B.2.1.3  Methods Used to Derive Final Depths

The Complete Coverage and Object Detection grids were “finalized” in CARIS according to
depth. Per the CARIS HIPS & SIPS 7.1 Users Guide, a finalized BASE surface “is a finished
version of the surface that is ready for export.” Designated soundings were incorporated into
the BASE surfaces when finalized making certain the least depth sounding was honored in the
grid. Given that the maximum project depth is < 20 meters the Complete Coverage MBES
surfaces were finalized at 1-meter resolution.

Final BASE surface resolutions are unique for each survey area and are described specifically
in the respective descriptive reports.

B.2.2 Imagery

Preliminary QA/QC of the SSS data occurred simultaneously with data acquisition. However,
all formal data processing occurred at OSI’s home office. SSS data backup and shipment
methodology were identical to the treatment of MBES data as described earlier. Once these
data were received by the home office the backup disk’s files and acquisition log were
reviewed to verify line names and file size and to remove any aborted lines from the preprocess
folder prior to converting the data in CARIS HIPS. All lines copied from the acquisition
computer were entered into the survey processing log, which was used to track the processing
progress of each line and to enter all notes pertinent to individual lines or days.

CARIS HVFs were created to convert EdgeTech JSF data files. Different vessel files were
created for the two collection configurations; towed and rigid pole mount. All Preprocess
EdgeTech JSF data were converted to the HDCS data format in CARIS’ Conversion Wizard.
For the towed SSS configuration, towfish positions were converted from the JSF sensor
position field and fish heading was computed from course made good (CMG) from vessel
navigation. The towed SSS vessel file is a “zero” configuration because all tow point offset
and layback calculations were performed real-time in HYPACK SURVEY; therefore, no
additional towfish position calculations were necessary in CARIS HIPS/SIPS. Since
HYPACK performed the layback calculation not all sensor data, i.e. cable out and ship
position, were imbedded in the CARIS processed files. Therefore, post-conversion, position
and sensor data were inserted into the SSS HDCS lines with the CARIS Generic Data Parser
by extracting the sensor data from the HYPACK RAW files.

For the fixed mount SSS configuration, towfish positions were converted from the JSF sensor
position field and fish heading was taken directly from the POS MV. Since the SSS towfish
was mounted rigidly in relation to the vessel frame, the vessel heading derived with the POS
MYV was applied during SSS processing instead of using heading from the SSS compass sensor
or deriving it from course over ground averaging. The real-time fixed mount SSS imagery
was acquired using 1 Hz position and heading input directly from the POS MV. However,
during post processing, 10 Hz position and heading data were substituted for the slower update
data using the CARIS Generic Data Parser.
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The EdgeTech 4125 JSF file format does not record bottom tracking, i.e. towfish altitude. The
CARIS SIPS bottom tracking routine was used to 1) bottom track the imagery and 2) populate
the altitude field as required in the HSSD. Although the CARIS SIPS bottom tracking routine
was ultimately used to accomplish (and fine tune) the bottom tracking solution, the bulk of the
bottom tracking effort was accomplished by alternate means as follows. In practice, line-by-
line coincidental multibeam nadir depths were exported, corrected for the difference in draft
between the MBES and the fixed mount SSS, and imported to the fixed mount SSS dataset via
the CARIS Generic Data Parser. The CARIS SIPS bottom tracking routine was then employed
to review the imported bottom tracking solution and make the relatively few minor
corrections/edits that were needed.

The fixed mount SSS vessel file is not a “zero” configuration. During fixed mount SSS
acquisition and subsequent onboard QA/QC data processing, HYPACK SURVEY-derived
SSS positioning data were utilized. However, in order to improve contact selection and mosaic
quality, the CARIS Generic Data Parser was used to overwrite positioning/heading recorded
in the field with high rate position and heading information extracted from the daily Applanix
POSPac files. The fixed mount SSS vessel file includes forward and starboard towpoint offsets
which allowed the fish position to be recomputed using CARIS SIPS. The fixed mount
configuration did not have a variable “cable out” field; therefore, this value is always shown
as zero.

For the towed SSS (4200-MP) both high- and low-frequency data were acquired. However,
the high-frequency data (600 kHz) were of sufficient quality that the low-frequency data were
not used for either target picking or mosaicking. Therefore only the high frequency data were
converted. For the fixed mount SSS (4125) only the low-frequency (600 kHz) data were
converted.

Navigation time stamp irregularities were edited and navigation data were reviewed in the
CARIS Navigation Editor. Each side scan line was reviewed in CARIS Attitude Editor to
ensure that the towfish attitude, depth, and cable out (if applicable) were properly represented
and that there were no gaps or problems with these parameters.

The CARIS Side Scan Editor was used to bottom track, slant range correct, and apply image
enhancement correction to the data. Processing was completed as follows:

1. Review the raw side scan data in Side Scan Editor. Use automated bottom detection
algorithms where possible and then correct any automated bottom tracking errors by
manually re-digitizing the bottom trace.

2. Slant range correct the side scan lines with a resolution of 0.03 meters to convert the
across track axis from time to distance and remove the water column from the imagery.
Calculate and apply an average speed of sound value from sound speed casts acquired
during the corresponding day of side scan acquisition. Sound speed values used for
slant range correction varied between 1526 m/s and 1543 m/s. The slant range
correction sound speed used for each day of side scan acquisition is noted in the
processing log.
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3. Lines were AVG corrected to normalize angular response across the swath.

During pre-survey planning, the CARIS HIPS and SIPS ContactFeatures.hcf file located in the
CARIS\HIPS(x64)\System directory was modified by OSI to include additional Contact
Feature types with which to classify contacts in Side Scan Editor. The additional contact types
are included in Table 6 below, along with their graphical display in CARIS HIPS and a brief
description of the conditions under which the contact type is selected. The OSI-modified
ContactFeatures.hcf file is provided within the project deliverables Ancillary Data directory
for AHB’s use during the survey acceptance review.
Table 6
Modified OSI Contact Types Selected in Side Scan Editor

Unknown Contact
UNKCNT B ?

Feature whose nature cannot be determined

Obstruction - ht 0.7m+

SIGCNT

Feature that has a SSS measured height > 0.7 meters

or has significant size or features, i.e. submerged platform ruins, loose fish net, subm piling, etc. (ask for 2" opinion if unclear)

Feature with insig height
INSCNT
Feature that has a 5SS measured height between 0.25m and 0.7m

Fish contact
FSHCNT
Fish

Wreck
WRECK
Boat, ship, sailboat, barge, etc. , any feature that might be a wreck.

Platform

OFSPLF E

Oil production platform. High water, not submerged.

Post/Pile/Dolphin (detached)

PILPNT D
Dolphins, posts, or piles. Freestanding/detached from larger structure

* Use for signs on posts — if charted use NAVAID; Do not use “pile” in remarks, use “piling”

Navigational Aids (charted)
NAVAID
Navigation Aids that can be verified against raster chart, ENC, or CSF

Flagged by QAQC

AN
QAQC .
0

* Do not use during contact picking, for review purposes only.

Possible Gas Leak
BUOYS
A depression with possible gas bubbles (i.e. tall shadow, bubbles in water column); Confirm in MB

Cable

NPCA S ta e e
Linear features that are not a pipeline

Pipeline

NPPL —0—9—0-—9g-—G—0—q—a-

pipeline only

Once image processing was completed contacts were selected in the Side Scan Editor waterfall.
Objects were identified by the presence of sonar shadows. Shadow lengths were measured and
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converted to heights. Contacts with significant heights or horizontal dimensions were
positioned and created at the top (closest to nadir) of the shadow, and attributed with the
following information: feature type (obstruction, platform, unknown, wreck), height, width &
length (if significant), and processor remarks. Heights were measured with the shadow tool
and lengths and widths were measured with the distance tool.

SSS lines were reviewed a minimum of two times by more than one data analyst to make
certain that all significant contacts were selected that may require investigation. The contacts
selected in Side Scan Editor were visible in the HIPS & SIPS Display window. Contacts were
reviewed in CARIS Subset Editor using full sounding density while toggling between rejected
soundings being shown or hidden.

In order to ensure sufficient coverage, GeoBars (Georeferenced Backscatter Rasters) were
created for each line. The GeoBars were generated with a resolution of 0.15 meter and were
saved in the HDCS line folder for each side scan line. With all the GeoBars loaded for the 100
percent side scan coverage, mosaics were generated with a 0.25-meter resolution.

During initial home office processing, the 100 percent coverage mosaics were reviewed for
coverage gaps and poor quality imagery that would necessitate SSS fill-in lines. Fill-in lines
were assigned to the field team as necessary to supplement the initial mainscheme coverage.
After the completion of survey and processing operations, the final 100 percent coverage
mosaic was exported from CARIS HIPS and SIPS to individual GeoTiffs.

B.2.2.1  Methods Used to Maintain Data Integrity

See Section B.2.1.1.

B.2.2.2  Methods Used to Achieve Object Detection and Accuracy Requirements
As noted earlier, two SSS systems were employed on this project.

For the towed SSS, an EdgeTech 4200-MP, the “high speed” mode was utilized. In this mode
the system has two pulses in the water during each ping cycle effectively doubling the ping
rate of traditional side scan sonar systems. This system was operated only at the 75-meter
range scale.

For fixed mount SSS operations utilizing an Edge Tech 4125, a traditional “single pulse” SSS,
the system was operated only at the 50-meter range scale. At this range scale the system’s
pulse repetition interval was sufficiently fast for survey speeds achieved.

B.2.2.3  Methods Used to Verify Swath Coverage

During home office data review the 100 percent side scan coverage mosaic was updated
frequently and reviewed for gaps or poor quality data that would require fill-in lines or re-runs
of the mainscheme line. The review process occurred while the field team was still mobilized
onsite.
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Line spacing was planned such that there was ample overlap between adjacent lines for the
single 100% coverage. All side scan lines were planned with the intention of achieving outer
beam overlapping coverage of 20 meters. MBES near-nadir data provided secondary SSS
nadir coverage which was useful in assessing near-nadir SSS contacts. Given that the
Autopilot maintained line steering within 2 meters of the planned line and the towfish was
flown at an altitude as not to diminish the scanning range, full swath coverage was achieved
on the majority of mainscheme lines. Gaps in side scan coverage that occurred when the vessel
steered off line to avoid oil platforms were subsequently filled with side scan development
lines and/or Complete Multibeam to the extent that safety of the vessel and platforms allowed.
SSS shadows created by platforms even if the vessel did not have to steer offline were also
filled with either additional SSS or Complete Multibeam which were acquired from a different
perspective. In many cases large fish balls caused gaps in the 100% SSS coverage mosaic.
These gaps were also filled with either additional SSS or Complete Multibeam.

B2.24 Criteria Used for Contact Selection

The criteria used to select contacts was based on the guidance provided in the HSSD Section
6.1.3.2 Side Scan Sonar Contacts, which defines a contact as significant based on its shadow
height in different depth ranges. The HSSD significant contact specifications are summarized
in Table 7.

Table 7
Significant Contact Selection Criteria

Surrounding Depth or Area | Significant Contact Height

< 20 meters 1 meter

> 20 meters 5% of surrounding depth

No portion of the assigned survey area was found to be over 20 meters deep. Therefore, only
the <20 meter significant contact height criteria was considered. OSI used a more conservative
approach than required when selecting contacts to make certain that significant features would
not be overlooked for further investigation or correlation in the MBES record. All contacts
with a minimum height, based on shadow length, of 0.7 meters were selected. Features smaller
than 0.7 meters were sometimes chosen if they appeared navigationally “significant” in relation
to the charted depth.

At times there was an abundance of fish encountered within the project area, represented in the
side scan record as individual fish and as schools. Fish contacts were created when the fish
schools, singular swimmers or dolphins created detectable shadows in the side scan record.
Singular fish presented themselves in the record most often as hard returns with long detached
shadows. Sometimes the fish and dolphin reflections were evident in the water column, which
also created shadows in the SSS record.

Individual fish contacts having a well-defined, characteristic detached shadow were not
investigated further. When available, coincidental SSS and/or MBES data were consulted to
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bolster the decision not to investigate. Conversely, there were many cases where the character
of an interpreted individual fish shadow was not convincing, i.e. further investigation was
warranted. In these instances additional data were acquired to disprove the questionable fish
feature.

The presence of fish contacts in the HIPS display window was also helpful during editing of
bathymetry as an indicator to the hydrographer to anticipate noisy data. Fish contacts were not
assigned heights.

Most side scan contacts were symbolized as point features; however, sections of exposed
pipeline were digitized as linear contacts. At times, contacts without a shadow were selected
if there was a noteworthy shape or size to the item, despite its insubstantial relief.

B.2.2.5  Compression Methods Used for Reviewing Imagery

The CARIS Side Scan Editor “Average” option for compression was used while reviewing
imagery. Per the CARIS HIPS and SIPS Help contents, the Average Compression option
“compiles average pixel intensity within a group of pixels spaced at regular across-track
intervals.” The computer monitors used for data processing were high resolution (1920 x
1080), and the full width of the screen was utilized while reviewing the side scan waterfall.
Therefore, the data compression effects were minimized.

B.2.3 Sound Speed
B.2.3.1  Sound Speed Profiles

As mentioned earlier an ODIM MVP was used as the primary sound speed profiling device.
An AML Base-X profiler was used to acquire comparison cast data. All automated and manual
comparison casts were reviewed in the field as they were acquired.

In the case of the MVP, profiles were plotted on the HYPACK SURVEY screen along with a
recent history of preceding casts. In practice, as MVP casts are performed they are plotted in
profile in HYPACK SURVEY displayed as a red line. As subsequent profiles are performed
the previously acquired profile changes to blue and the newly acquired profile is plotted in red.
This process is repeated each time an MVP cast is acquired with the older profiles turning a
lighter shade of blue each time a new profile is written in red. In the case of manual casts using
the AML Base-X, the profiles were downloaded with a dedicated laptop computer as they were
acquired, plotted for QA/QC and incorporated into the “weekly” comparison cast routine in
Velocwin. MVP casts are automatically (or manually) transmitted to the HYSWEEP
SURVEY platform for use by the program in real time.
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Sound speed profile data were continually assessed in the field by the following means:

e their shape in relation to previously acquired profiles

e their effect on the real time sounding wedge as displayed in HYSWEEP SURVEY

e the profile surface speed in comparison to the real time surface speed output by the
MBES-mounted AML Micro-X sound speed sensor

As these data were received at OSI’s home office, the delivery disk’s file listing was compared
to the acquisition log to verify file names and size and to remove any aborted casts from the
preprocess folder prior to converting the data to SVP files.

For the automated cast data, the ASCII CALC files logged with each MVP cast were converted
using NOAA’s Velocwin software. The BROOKE-OCEAN MVP Automatic mode was used
to convert one or more CALC files and append them to a CARIS HIPS SVP file, referred to as
the “CARIS HIPS Accumulating SVP File” in Velocwin. All individual MVP casts, attributed
with position, date and time of cast, were concatenated to a survey level SVP file (ex:
H12907 Master.svp) for use in sound speed correction of survey lines in CARIS HIPS.

The manual sound speed cast data were not incorporated into the final dataset. Rather, these
data were used only for sound speed comparison.

During the Load SVP step in the HIPS Batch Editor, the Master SVP file was chosen and the
Edit option was selected to open the CARIS SVP Editor. All new casts that had been appended
to the SVP file were reviewed and the Extended Depth modified as needed.

The CARIS Profile selection method used to apply sound speed correction was the “Nearest
in distance within time” option. Two hours was chosen as the time increment. Prior to the
final application of sound speed correctors, the Master SVP file for each survey was opened as
a Background File in CARIS HIPS to verify that the cast positions all fell within the area
surveyed.

The frequent AML Base-X and MVP comparison casts acquired during the “UTC midnight”
changeover were converted in Velocwin to generate ZZQ files used to compare the sound
speed profiles with the “Weekly DQA” tool. The SVP comparison casts were not appended
to the CARIS SVP file used for sounding correction. A listing of DQA results is included in
DR Separate I1.

B.2.3.2  Surface Sound Speed
Frequent comparisons were also made between the surface sound speed of the stationary MVP

and the surface sound speed recorded by the AML Micro-X at the time of the cast. The surface
DQA comparisons were accomplished using Velocwin’s “Daily DQA” tool.
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B.2.4 Horizontal and Vertical Control
B.2.4.1 Horizontal Control

RTK GPS positioning and water level determination were employed during pre- and post-
survey MBES patch testing, pre-survey side scan sonar positioning verification, and settlement
and squat testing.

This approach was chosen in order to achieve higher accuracy positioning of the discrete
objects used to determine the angular biases of the MBES transducer and to accurately account
for the vessel’s vertical response to changes in speed, i.e. settlement.

B.2.4.2 Vertical Control

Predicted, Preliminary and Verified tides were downloaded from the CO-OPS SOAP web
services website and were re-formatted as TID files to be used in CARIS HIPS tide correction.

The preliminary tidal zoning file (ZDF) that was provided by CO-OPS with the OPR-K354-
KR-16 Tides Statement of Work was modified as a result of analysis of BMPG data as
described earlier. Tide correctors from the LAWMA (876-4227) gauge along with the
modified tide zoning file, “K354KR2016 Revised Zoning 20161103.zdf” were used to reduce
soundings to MLLW in CARIS HIPS. The time and height corrections in the zoning file were
used to extrapolate the water level measured at the tide gauge to each modified discrete tide
zone. The zoned tide correctors were then applied to the soundings.

B.2.5 Feature Verification

During home office processing contacts were exported (daily) from HIPS and SIPS to an
ASCII text file, which was reformatted and imported into a CARIS Notebook edit layer (HOB
file). Senior processing personnel would identify the contacts that required additional
investigation from the contact HOB file. An item investigation HOB layer was created which
included the positions of all side scan contacts and outstanding soundings to be developed with
additional MBES coverage. The Investigation HOB layer was exported to an S-57 (.000) file
which could be opened as a background layer in HYPACK SURVEY during acquisition of
development lines. Several S-57 feature symbols were chosen and re-defined for OSI tracking
purposes; the in-house descriptions of the tracking objects are included in Table 8.
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Table 8
Description of Investigation Tracking HOB Layer

S-57 Symbol Description Parameters

SSS: Incorrect contact,
Incomplete contact,
Additional contact

@ Indicates Survey Data description needed

® BOYISD Issues _ .

MB: Fish still in data,

Tide Issue, Heave Issue

acqsts = Investigate

Any Ftr that is not
significant should be

marked examined.

® BOYSPP Indicates Ftems as
Examined

Downgrade any
investigation item that is
found to be insignificant.

Item Investigations
Shoal Areas

A Indicates Resolved Photos

BOYLAT (green) Survey Task Items

acqsts = Resolved

Indicates Unresolved
‘ BOYLAT (red) Survey Investigations

Item Investigations
Shoal Areas
Photos

B S

___________ Cartographic Lines and Indicates Lines e.md
o ; Areas that require
Areas

. acqsts = Investigate
r‘ ? ,‘ additional survey data 4 &
! !

Following the field team’s completion of investigation and development tasks, feature
verification, MBES and SSS coverage confirmation were accomplished through intensive
review employing various data sources and software. Prior to the conclusion of survey
operations, the home office project manager reviewed the data to ensure the following:

e Object Detection MBES coverage was obtained over significant SSS contacts.
e Charted soundings were verified or disproved with MBES coverage per guidance
included in HSSD Section 5.2.2.1. Bathymetric Splits.

e Complete MBES coverage was obtained over significant shoals.
e (SF “assigned” items were adequately addressed.
e Photos were obtained of high-water features, e.g. platforms.
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The item investigation and development lines were converted and processed in CARIS HIPS
following the bathymetry processing procedures outlined above. CUBE surfaces with a grid
resolution of 0.5 meters were created over the investigated significant features. The density
layers were reviewed to verify that the Object Detection Coverage requirement of 5 soundings
per node was met. Least depths were designated on all verified features and significant
contacts.

Contacts were evaluated with respect to available correlating SSS as well as BASE surfaces,
charted information, and designated soundings. Significant contacts were evaluated in full
density sounding subsets to ensure that there was adequate MBES coverage.

Contacts, contact images, and designated soundings were exported from CARIS HIPS and
SIPS. All contacts were imported into a HOB file which was the foundation of the S-57 SSS
Contact File included with the project deliverables. The designated soundings were imported
into a HOB file, as well, and were utilized in the production of the S-57 Final Feature File
(FFF), wherein the positions and designated least depths were used to update existing chart
features or create new features in the FFF.

Shoal soundings, designated soundings and contacts were compared to the largest scale charts
in the survey area to identify Dangers to Navigation (DtoNs). All DtoNs were submitted to
AHB as attributed S-57 .000 files per the specifications laid out for Contractors in the HSSD.
All features submitted as DtoNs were included in the FFF.

I. SSS Contact File

All SSS contacts, point and linear features, were exported from HIPS and SIPS to an ASCII
file and imported into a Notebook HOB File. Individual contacts were correlated manually
with respect to available overlapping SSS coverage, BASE surfaces, charted information, field
photos and observations, and designated soundings. Correlation was accomplished by
selecting all contacts found to represent the same independent feature in the Display Window
and assigning each group a unique correlation number in the Primary Key ID (prkyid) attribute
field. All contacts with the same prkyid are a correlating contact group. Singular contacts
were not assigned a correlation number.

Each feature in the S-57 SSS Contact File includes the required NOAA Extended Attributes
as specified in the table from Section 6.1.3.3 of the HSSD. The contact number is composed
of the SSS line number and the number assigned in the HDCS line Contact file, for example:
201608261346190001.

The contact image from SIPS Side Scan Editor is embedded in the S-57 contact file in the
Image (images) attribute field.
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II. Final Feature File

A Final Feature File (FFF) in S-57 .000 format was created in CARIS Notebook per the
guidance in HSSD 2016 Section 7.3. The feature file included all source features assigned for
investigation in the OCS-provided Composite Source File (CSF) and new navigationally
significant objects discovered during the survey that required additional description beyond
inclusion in the submitted bathymetric surfaces. The FFF includes new survey features, and
updated and disproved charted features. Per Hydrographic Technical Directive 2016-03, July
21, 2016 the FFF is submitted in the WGS84 datum, unlike all other project deliverables which
are submitted in the NAD83 datum.

OSI followed the feature attribution guidance in Section 7.5, S-57 Feature Attribution, of the
2016 HSSD, while building the FFF. In particular, the determination of a charted feature as
an "Update" or a "New/Delete" item was based on the guidance that an Update is a
modification to "attribution, geometry, and/or feature object class" and that a charted feature
should be given the New/Delete treatment when the distance between the charted position and
new position is "greater than 2mm at the scale of the survey (20m for 1:10,000)."

New or Updated point features’ depths (VALSOU — value of sounding) and positions were
imported into Notebook from Designated soundings selected in CARIS HIPS and SIPS.

High-water features such as platforms were digitized into the FFF with the position determined
from the MBES data or from the 25-centimeter SSS mosaic.

Descriptive information pertinent to each feature was entered in the IHO S-57 attribute fields
and the NOAA extended attribute fields as specified in Section 7.5 and Appendix F: Feature
of the HSSD.

The following attributes were updated for each item in the FFF:

e SORDAT (Source Date) — Final day of survey. New or verified features only.

e SORIND (Source Indicator) — Survey registry number, ex: US,US,graph,H12905.
New, updated or verified features only.

e descrp (Description) — New, Update, Delete, Retain

e remrks (Remarks) — Processing remarks including survey techniques, feature
classification (i.e. obstruction, rock, platform).

e recomd (Recommendations) — Hydrographer’s charting recommendations.

e sftype (Special Feature Type) — Only updated for ATON and/or DTON items.

e images (Images) — Contact images, CARIS screen grabs or shoreline photographs
included in the multimedia folder. Not Applicable for “Delete” features.

The mandatory S-57 attribution for each S-57 object class was updated as specified in Section
7.5 of the HSSD. The required attributes vary with S-57 object class (i.e. OBSTRN, OFSPLF,
SBDARE).
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B.2.6 Bottom Samples

Bottom sample positions were imported into CARIS Notebook from the HYPACK target file
into the FFF. The bottom samples were classified as SBDARE (Seabed area) objects and
attributed as instructed in Section 7.5 of the HSSD. The full bottom sample description was
entered into the Remarks attribute field. The photo names of each bottom sample were entered
into the Images attribute field.

B.3 Quality Management

A full cross line sounding data set was acquired at the start of acquisition, prior to collection
of mainscheme coverage. Cross lines were run nominally perpendicular to mainscheme lines.
Soundings from mainscheme lines and cross lines were compared periodically throughout
survey operations using preliminary CUBE surfaces and using CARIS HIPS Subset Editor.
Cross line comparisons provided confirmation that the system offsets and biases were entered
correctly and verified the accuracy of sounding correctors (i.e. tide, sound speed, TrueHeave).

The planned cross line mileage was > 8% of mainscheme mileage as required in the HSSD for
Set Line Spacing coverage.

Statistical quality control information was generated periodically during data acquisition by
comparing the beams of each cross line to CUBE Surfaces generated from mainscheme data
using the CARIS QC Report Utility. At the completion of MBES data processing, for each
survey, difference surfaces were generated between a surface compiled from
mainscheme/investigation MBES data and a surface compiled only from cross line MBES data.
The results from the difference surface creation and the statistical analyses are discussed in the
descriptive reports for each survey.

Detailed line queries were utilized periodically throughout data processing to be certain all
necessary processes were completed and the right corrector files were applied to all the lines.
The line queries were also used to calculate line mileage and were compared to processing logs
to verify line names and be certain that no aborted lines were included in the final data products.

The standard deviation, depth and uncertainty layers were reviewed to identify possible
systematic errors related to sound speed, tide, and TrueHeave correction or to errors in system
alignment.

Sound speed profiles were plotted by day to visualize the variation over time and space
(Figures 8 and 9). As compared to OSI’s south Louisiana survey assignments of the past few
years this survey was conducted in a relatively stable water column in terms of sound speed
variation, i.e. there were few sound speed profiles that exhibited a rapid increase or decrease
in sound speed at the surface and within the water column (Figure 8). In fact, only on the last
two days of the survey was a drastic sound speed profile noted (Figure 9).

Surface sound speed logged in the raw HYPACK files was extracted and plotted for every line.
High deviation or rapid changes in the surface sound speed over a line, were also an indicator
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of increased sound speed error in sounding correction, which was most severe in the outer
beams (Figure 10). Lines that exhibited relatively high variability in the surface sound speed
were reviewed in the CUBE surface layers and edited as needed in Subset Editor.

Junction comparisons between current and prior hydrographic surveys were accomplished
using the CARIS HIPS difference surface function.
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Figure 8. Plot of sound speed casts for August 24, 2016 (DN 237).
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Figure 9. Plot of sound speed casts for September 29-30, 2016 (DN 273-274).
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Figure 10. Surface sound speed plot by survey line for August 24, 2016 (DN 237)
spanning 16:00 to 22:00 UTC.

B.4 Uncertainty and Error Management

Estimates for the uncertainty of all measurements associated with sounding collection, were
gathered from either reported manufacturer system accuracy or from statistics calculated from
multiple measurements of the value in question.

Error is defined as the difference between a measured value and the true, or accepted, value.
Since the true sounding value is not known ahead of time, an accurate error value cannot be
reported with confidence. Uncertainty, not error, is the chosen parameter to quantify sounding
accuracy such that it can be reported in terms of an interval of confidence around the measured
value. The uncertainty associated with a measurement is reported as the standard deviation
(o), or the root mean square deviation, of the value from the mean.

The combined uncertainty value per sounding, or the Total Propagated Uncertainty (TPU), was
calculated using CARIS HIPS. Standard deviation values for vessel offsets, motion, draft and
alignment measurements were entered into the vessel HVF “TPU values” section at the 1-
sigma level. The HVF uncertainty values along with uncertainties associated with tide and
sound speed were used in combination with the sonar model in the DeviceModels.xml file to
assign a total horizontal uncertainty (THU) and total vertical uncertainty (TVU) for every
sounding.
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B4.1 Total Propagated Uncertainty (TPU)

Tables 9 lists the standard deviation and uncertainty estimates used for all measurements
incorporated into the TPU estimates for the Reson 7125 echo soundings.

Table 9
Reson 7125 Uncertainty Estimates
Uncertainty Values Included in CARIS HVF Files & Compute TPU Fields

Heading Measurement ¢ (deg) 0.02 XYZ Offset Measurement ¢ (m) 0.015
Heave % Amplitude 5.00 Vessel Speed Measurement ¢ (m/s) 0.530
Heave Measurement ¢ (m) 0.05 Loading Measurement ¢ (m) 0.030
Roll Measurement ¢ (deg) 0.02 Draft Measurement ¢ (m) 0.030
Pitch Measurement ¢ (deg) 0.02 Delta Draft Measurement ¢ (m) 0.030
Navigation Measurement ¢ (m) 1.00 MRU Align StdDev Gyro (deg) 0.10
Transducer Timing ¢ (sec) 0.01 MRU Align StdDev Roll/Pitch (deg) 0.10

Navigation Timing ¢ (sec) 0.01
Gyro Timing o (sec) 0.01 Tide Measurement ¢ (m) 0.03
Heave Timing o (sec) 0.01 Tide Zoning Vertical Uncertainty (m) 0.09
Pitch Timing o (sec) 0.01 Sound Speed Error Measured (m/s) 1.00
Roll Timing o (sec) 0.01 Sound Speed Error Surface (m/s) 1.00

The POS MV 320 manufacturer recommended uncertainty values for the heading, heave, roll,
pitch and timing measurements were entered in the HVFs.

The standard deviation values for the XYZ Offset and static draft measurements were
calculated from distances acquired with the coarsest tool used to verify vessel offsets, the steel
tape.

Standard deviation for the loading measurement was calculated from the measure down values
acquired on the port and starboard sides as well as pressure gauge-derived static draft values
measured during the daily changeover.

The uncertainty for the delta draft was established by calculating the standard deviation of the
differences between settlement values of reciprocal runs per each vessel speed tested. The
settlement curve is included in DAPR Appendix I.

The MRU Alignment standard deviation values were calculated from the bias values estimated
by multiple hydrographers who had individually processed the patch test data.

As noted earlier the combined tide measurement and zoning uncertainty was not provided by
CO-OPS in the Tides SOW. The Tides SOW states that, “there is insufficient data with which
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to perform an accurate error estimation.” Tide measurement/zoning uncertainty was supplied
by JOA Surveys after inclusion of BMPG data into zoning analysis.

Measured and surface sound speed error estimates are the minimum (or near minimum)
recommended values in Table 4.9 of the April 2014 NOS OCS Field Procedures Manual. The
values tabulated above are chosen since 1) MVP sound speed casts were acquired at an interval
of < 15 minutes and 2) the surface sound speed gradient was negligible for the majority of the
survey period.

C. CORRECTIONS TO ECHO SOUNDINGS
C.1 Vessel Configuration and Offsets
C.1.1 Description of Correctors

Vessel configuration parameters and offsets are measures of the location of the integrated
survey systems in respect to an established vessel Reference Point (RP) that serves as XYZ
point 0, 0, 0 within the vessel’s reference frame. The RP on the R/V Ocean Explorer was the
phase center or “bullseye” of the POS MV IMU. The measured offsets included the distance
between the MBES transducer phase center to the RP, the distances between the GPS antenna
phase centers and the RP, the distance from the fixed mount SSS to the RP, and the distance
from the top of the side scan sheave and the RP.

C.12 Methods and Procedures

As mentioned earlier a total station was used to complete a full survey of the R/V Ocean
Explorer on May 6, 2015 prior to mobilizing Project OPR-J377-KR-15. Since the 2015 total
station survey only one change was made to the physical configuration of the vessel. Near the
location of the POS MV antennas the boat was fitted with new spot lights. As a result the POS
MYV antennas were raised 2.0 feet (0.610 meters) in order to escape the GPS signal shadowing
effects of the new hardware. This year-to-year change is reflected in the table below.
However, since the antenna offsets are entered directly into the POS MV controller software
the change is not reflected any HVF.

The POS MV IMU was mounted on a permanent plate close to the vessel’s center of rotation
(Figure 11). The total station was used to measure the offsets from the IMU bullseye to the
POS MV GPS port and starboard antenna mounts, the Trimble SPS 461 GPS antenna mount,
the top of the towed SSS sheave and multiple port/starboard reference points including draft
measurement points. When the multibeam/fixed mount SSS pole mount was fully deployed,
the offsets between the MBES and fixed mount SSS transducers were related to the RP via
repeated measurement between the transducers and the starboard side reference points
mentioned above. These measurements were made using a steel tape measure. The MBES
and fixed mount SSS transducers are located directly below the starboard side reference points
allowing for an unobstructed measurement path.
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The IMU and transducer mounting hardware were co-aligned employing a gyrocompass while
the survey vessel was firmly secured to the dock in flat calm conditions. The vessel was made
stable by pushing ahead with the engines against taut dock lines.

C.13 Vessel Offset Correctors
Instrument offsets input to the CARIS vessel configuration files are included in Table 10

below.

Table 10
R/V Ocean Explorer Sensor Offsets

R/V Ocean Explorer Offsets via Topcon

Total Station Survey or Measured Relative Forward | Starboard UP UP
to Permanent Shipboard Benchmarks. Positive | Positive Positive Positive
Offsets are relative to Reference Point (RP) (m) (m) w.r.t RP W.r.t.
or Waterline (m) waterline (m)
RP IMU Center 0,0,0 0.000 0.000 0.000 -0.480
POS MV GPS Antenna Phase Center Port 4.900 -1.200 6.339 5.859
POS MV GPS Antenna Phase Center Starboard 4.883 1.239 6.333 5.853
Positioning Integrity Comparison GPS Antenna 2713 0.948 7972 7497
Phase Center

7125 Transducer Phase Center 0.629 2.870 -1.423 -1.903
Fixed Mount SSS (EdgeTech 4125) 1.139 2.870 -1.016 -1.496
Towed SSS (EdgeTech 4200)

Top Of Sheave (Cable at top of sheave) -4.700 1170 3.160 2.680
Starboard Side Draft Measurement Point -0.325 2.542 1.975 1.495
Port Side Draft Measurement Point -0.329 -2.494 1.979 1.499
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R/V Ocean Explorer Systems Layout

o Reference Point
IMU Center
POS-MV Antenna
GPS Antenna
e 7125 Transducer Phase Ctr.
Fixed Mount SSS
Towed SSS Sheave
Draft Observation Pt.
MVP Sheave

Figure 11. R/V Ocean Explorer systems layout.

-57 - Data Acquisition and Processing Report



OPR-K354-KR-16 OCEAN SURVEYS, INC.

C.l14 Layback
C.1.4.1  Towed Configuration

Towed side scan sonar fish positioning was accomplished in real-time using HYPACK
SURVEY configured using the Towfish device (towfish.dll). The Towfish device calculates
fish position based on fixed sheave offsets relative to the RP, real-time ship position, cable out
value, and towfish depth. The real-time calculation incorporates the Pythagorean Theorem and
a multi-segmented cable discretization approach to predict how the towfish follows the main
vessel. The layback calculation can be empirically fine-tuned by adjusting the number of cable
segments and modifying the catenary factor. Field testing conducted prior to this survey
indicated a 5-segmented cable model and a catenary factor of 1.0 were appropriate for this
particular setup.

The real-time calculated towfish positions were output from HYPACK SURVEY and
delivered to Discover via a serial cable connection. Discover then stored this position in the
SSS data files. Since all required offsets and parameters were already incorporated into the
stored position, the data were imported into a zeroed vessel file for CARIS SIPS processing.

Side scan sonar positioning accuracy was verified prior to commencing survey operations by
comparing the position of a known feature (position determined using MBES data) to the same
feature positions as recorded in multiple SSS passes. The multiple SSS passes were collected
at varying ranges and distances from the feature to confirm overall system accuracy. Test
results are presented in DAPR Appendix II.

C.1.4.2  Fixed Mount Configuration

When operating the side scan in the rigid, fixed-mount configuration, positioning was
accomplished in real-time using HYPACK SURVEY configured using the generic offset
device (genoffset.dll). HYPACK SURVEY transmitted fish position to the SSS acquisition
software package Discover based upon the fixed physical offsets of the EdgeTech 4125 SSS
relative to the vessel RP. The Discover software also recorded vessel heading (analogous with
fish heading) which was supplied to the software via a direct serial connection to the POS MV.

As mentioned earlier, a utility developed by OSI was used to extract high rate position and
heading data from the raw POSPac files. This information was used in recalculating fixed-
mount side scan sonar fish position. The practice of recalculating fish position using high rate
position data via the CARIS Generic Data Parser utility results in image mosaics that have far
less pixel stretching artifacts than realized using the relatively slow update rate
positioning/heading recorded with the Discover software in real time. Recalculating fish
position in CARIS SIPS required that a non-zero vessel file was used, i.e. a vessel file
containing the starboard and forward offsets of the fixed mount towfish relative to the vessel
RP.
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Like the towed SSS, positioning accuracy of the fixed mount system was verified prior to
commencing survey operations by comparing the position of a known feature (position
determined using MBES data) to the same feature positions as recorded in multiple SSS passes.
The multiple SSS passes were collected at varying ranges and distances from the feature to
confirm overall system accuracy. Test results are presented in DAPR Appendix IL

C2 Static and Dynamic Draft
C.2.1 Static Draft
C.2.1.1  Description of Correctors

Static draft is the vertical distance of the echosounder transducer below the water line and is
added to the observed soundings during data processing in CARIS HIPS. The vertical offset
between the transducer phase center and the RP was entered into the HVF Swath 1, Z-value
field. A vertical offset to account for the distance from the RP to the water surface was updated
nearly once a day into the Waterline Height field in the HVF. The Z-value and the waterline
corrector added together equaled the static draft of the echosounder transducer phase center.

C21.2 Methods and Procedures

Static draft measurements were taken during mobilization, prior to the start of the survey (July
22,2016, DN 204), and periodically throughout the term of the survey. Direct measurements
or “measure downs” from the water surface to both the starboard and port draft observation
point “benchmarks” were made employing a fiberglass stadia rod or steel tape measure. The
waterline height above the RP was determined by averaging the differences obtained from
subtracting the measured distances from the water surface to the benchmarks from the known
vertical offsets between the RP and the benchmarks. Minor variations in vessel attitude were
negated as the final measured waterline height value is an average of the port and starboard
measured values.

A GE/Druck pressure sensor (water level gauge) was installed within the transducer pole
providing an alternate method to monitor the change in static draft due to changes in vessel
loading. The pressure sensor was installed at a fixed elevation within the transducer pole. The
transducer mounting flange at the bottom of the transducer pole was fitted with a small
diameter copper orifice making the transducer pole, in effect, a stilling well. The pressure
sensor depth below the water surface was calibrated prior to the start of survey to determine
its vertical offset constant in reference to the RP. When the vessel was at a full stop for the
daily “UTC midnight” changeover, the pressure sensor water level data were logged for 5-10
minutes using HYPACK SURVEY. The water level values were extracted from the raw
HYPACK file and averaged to obtain the depth of the pressure sensor below the water line.
The waterline height was calculated by subtracting the vertical offset between the pressure
sensor and the RP from the pressure sensor average depth. Once the measure down-to-pressure
sensor corrector constant was established (and subsequently confirmed with later
measurements) the pressure sensor gauge water level determination method was used almost

-59 - Data Acquisition and Processing Report



OPR-K354-KR-16 OCEAN SURVEYS, INC.

exclusively for static draft measurements offshore as the sea state made measure downs
impractical when the vessel was offshore.

The waterline height measurement was calculated nearly daily using the pressure sensor water
level gauge method and measure down values were acquired when the vessel was offshore
during calm conditions. Given that the vessel’s operations dock was located well into the
Atchafalaya River (in fresh water) the dockside measure down values were not included in the
HVF for fear that these values would be biased due to the difference in water density between
the fresh water dockside location and the salt water environment of both the survey area and
the pressure sensor constant determination location. The waterline height measurement was
corrected to the vessel reference point and recorded in the acquisition log. Waterline height
values calculated from physical measurement, “measure downs,” or the pressure sensor gauge
data, were time stamped and entered into the CARIS vessel configuration file.

In CARIS HIPS, the time stamped waterline height correctors were added to the Z-value
vertical offset between the RP and the transducer phase center to obtain the echosounder static
draft.

C22 Dynamic Draft
C.2.2.1  Description of Correctors

Dynamic draft correctors account for the vertical displacement of the transducer when a vessel
is underway in relation to its position at rest.

C222 Methods and Procedures

Dynamic draft was measured on July 27, 2016 (DN 209) with the R/V Ocean Explorer
configured for data acquisition with an average loading weight and vessel trim. Calibration
test lines were acquired in water with a nominal depth of 10-25 meters; the sea-state was calm
during collection. Data were acquired along tracklines nominally 1,000 to 4,000 meters long
at regular intervals of speed, beginning with the engines at various “troll” settings and
increasing by 100 RPMs until the maximum practical survey speed was surpassed. Testing
was conducted around the time of slack tide and reciprocal line pairs were acquired at each
RPM setting to average out the effect of any current present. Tidal variations were accounted
for by recording a “drift line” with the vessel at rest at the beginning and end of each test line
run at speed. Lines, at speed or at rest, were only logged after the vessel speed leveled out or
stabilized to a steady state. The data were collected with the POS MV in RTK mode using a
base station approximately three miles away. However, the real time RTK solution was
abandoned in favor of a seemingly more stable single base IAPPK solution. The test was
conducted in the vicinity of the vessel’s home port in Noank, CT which is the location the
vessel was mobilized and from where initial calibrations were staged.
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Table 11 summarizes the as-measured results of the settlement test. In populating the CARIS
HVF draft table, the settlement curve generated using the values shown in Table 11 was
smoothed and densified using a 4™ Order polynomial curve fit in EXCEL. Settlement values
entered into the CARIS HVF were taken from the smooth curve at regular speed intervals.
These values are shown in Table 12.

Between Survey OPR-J377-KR-15 and the contemporary survey, OPR-K354-KR-16, the
propellers were changed on the R/V Ocean Explorer. The propellers used on the contemporary
survey have a different diameter and pitch as compared to those used on the 2015 survey. As
a result the settlement values derived during calibration testing for the contemporary survey
differ slightly at the high speed end of the curve as compared to the 2015 calibration results.
The difference was minor (but obvious) and is to be expected when using different propellers.

C.2.2.3  Dynamic Draft Correctors

Table 11
R/V Ocean Explorer As-Measured Dynamic Draft Correctors
RPM Speed Dynamic Draft
Both Engines M/S Knots Meters
Static 0 0 0
Troll Setting 1 1.62 3.15 -0.005*
Troll Setting 2 1.86 3.62 -0.010
Troll Setting 3 2.11 4.10 -0.012
Troll Setting 4 2.26 4.40 -0.023
600 3.51 6.84 -0.049
700 391 7.60 -0.075
800 4.39 8.55 -0.078
900 5.02 9.76 -0.110

*Negative value indicates the boat is settling. CARIS correctors are the opposite sign.
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Table 12

R/V Ocean Explorer - Polynomial Curve Fit Dynamic Draft Correctors
As entered into CARIS HVFs

Speed Dynamic
Draft Meters

M/S Knots

1.03 2.00 0.002
1.29 2.50 0.004
1.54 3.00 0.007
1.80 3.50 0.010
2.06 4.00 0.014
2.31 4.50 0.019
2.57 5.00 0.024
2.83 5.50 0.030
3.08 6.00 0.037
3.34 6.50 0.044
3.60 7.00 0.052
3.86 7.50 0.060
4.11 8.00 0.070
4.37 8.50 0.079
4.63 9.00 0.090
4.88 9.50 0.101
5.14 10.00 0.113

C3 System Alignment
C3.1 Description of Correctors

A multibeam sonar calibration was completed to determine residual navigation timing error
and angular biases in roll, pitch, and heading in the echosounder transducer alignment.

C32 Methods and Procedures

Prior to commencement of survey operations, a sensor alignment or patch test was performed.
The initial patch test of record was performed in the Atchafalaya River, Morgan City, LA on
August 16,2016 (DN 229). Data were acquired in accordance with HSSD March 2016 Section
5.2.4.1. The test area is the site of some conveniently oriented river bottom relief as well as
discrete bedforms. The discrete bedforms consist of sand waves oriented nominally
perpendicular to the Atchafalaya River flow. This area was chosen in lieu of a traditional patch
test area because an optimal patch test area, described in the HSSD as a “500-1000 meter long,
10-20 degree smooth slope perpendicular to the depth curve” is not readily available in the
vicinity of the project area.

Throughout the course of the survey the multibeam pole was occasionally recovered (pivoted
out of the water for transit and docking). Upon returning the pole to its deployed position an
abbreviated patch test was performed. In fact, given the unlikely possibility that the multibeam
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pole could move during operations, as a conservative measure, an abbreviated patch test was
performed daily whether or not the pole was recovered and redeployed.

For the “interim” or abbreviated daily patch tests reciprocal multibeam data were collected on
a short set of lines at a convenient time each day and processed onboard to confirm system
stability. In all cases results of interim roll testing indicated that the multibeam pole was stable.

The full suite of patch testing, i.e. a verification patch test, was performed at the completion of
the project on September 30, 2016 (DN 274). Patch test results of record are presented in
DAPR Appendix II

Pre- and post-survey patch test calibrations were accomplished employing RTK GPS
positioning. Interim roll check lines were acquired with the POS MV in DGPS mode.

For each full suite patch test, test lines were run multiple times to ensure system repeatability.
Patch test biases were determined in the following order: navigation timing error (latency),
pitch, roll, and heading. The CARIS HIPS Calibration Tool (Figure 12) was primarily used to
determine offset values. All patch test values were verified with the HYPACK HYSWEEP
patch test routine (Figure 13).

¥, CARLIS HIPS Calibration o =lol=

Ble fGbset Yow findow ik

Overall Statistics: Lt |
Lines: [ ] Prafiles: (5072 |
- "
Positions: 13550 | Depihs: [FiE62az c
N
Time Minimum: [Z004 295 205 Hh T
Manxdmum: [700
Latitude  Minimum: [F030° 20° 06023
[Northing]  Maximum: [1030° 20
Longhude  Minimum: [087 18 <
=|| [Eastingl  Maximum: 87 10

= o

Figure 12. CARIS HIPS Calibration Tool.
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# Patch Test —

Rall IGPS Latenc_p' Pitch I"r‘aw |

Test Settings and Fesult Sonar Head Selecton———

AngleTime Step 010 Adjustment 010 = Head1

Mumber of Steps 21 Initial Offset 0.41 = Head 2
Cell Size 10 Final Offset 0.31 L e

Depth Error

M anual Crozs Section Wertical Adjustment 0.0o < Previous | Mext » |

Start Test | Cloze |

Figure 13. HYPACK HYSWEEP Patch Test Utility.

For each parameter, multiple processing iterations were performed by multiple hydrographers.
The final offset values for each vessel file (HVF) are an average of the CARIS-derived values.
The final applied values, entered into the respective CARIS vessel files, are shown in Table
13. The patch test results were of high quality and repeatability.

The initial performance test of record was performed within the survey area on August 25,
2016 (DN 238). Verification performance testing was performed at the completion of the
project on September 30, 2016 (DN 274).

In practice a performance surface was created from a high density, near nadir sounding set
collected with the Reson 7125. Ten MBES lines were acquired over a relatively flat section
of seafloor or river bottom and processed in CARIS HIPS with the patch test bias values for
timing, pitch, roll and yaw entered into the HVF. A port and starboard beam filter of 45 degrees
was applied to the performance surface lines and a 1 m x 1 m Uncertainty Surface was
generated from the processed soundings. Two performance check lines that were run
perpendicular across the center of the surface were processed in CARIS HIPS as well;
however, no beam filter was applied. The CARIS HIPS QC Report Utility was used to
compare the beams of each performance check line to the performance surface to verify system
accuracy. Performance test results of record are presented in DAPR Appendix II.
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C33 System Alignment Correctors
Table 13
MBES Patch Test Alignment Correctors
CARIS Patch Test Results
Latency 0.00 sec
Pitch 0.00°
Roll -0.32°
Yaw (heading) 0.50°

C4 Positioning and Attitude
C4.1 Description of Correctors

DGPS correctors received from the USCG are used to improve positioning accuracy as
compared to operation in stand-alone GPS mode. Attitude corrections measured at the vessel
RP are applied to soundings to correct for vessel motion.

C.4.2 Methods and Procedures

An Applanix POS MV 320 V.4 was employed for motion, heading, and position determination.
Manufacturer’s stated accuracy and resolution values are tabulated below.

Table 14
POS MYV Specifications

POS MV 320 V.4 Manufacturer’s Specifications
Parameter Accuracy Resolution

Roll 0.02° 0.01°

Pitch 0.02° 0.01°

o
Heave > cm or 5./0 of 0.0l m
wave height
Heading 0.02° 0.01°

Prior to calibration of the POS MV, lever arm distances, mounting angles and the separation
distance between the port and starboard GPS antennas were entered in the controller software.
The heading accuracy threshold was set to 0.5 degrees. A GAMS calibration was run after the
heading accuracy had dropped below the 0.5 degrees threshold, keeping a straight course until
the calibration was completed. See DAPR Appendix III, Positioning and Attitude System
Reports for additional information on the POS MV configuration and calibration.
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CS5 Tides and Water Levels
Cs5.1 Description of Correctors

Tide correctors are applied to reduce the soundings to the Mean Lower Low Water (MLLW)
datum.

C52 Methods and Procedures

The water level station LAWMA, LA (876-4227), is the reference station for predicted,
preliminary observed, and verified tides for all hydrography for this project. The time and
range ratio correctors for applicable zones were applied to all tide correctors in CARIS HIPS
during the preliminary and final processing phases of this project. Predicted and preliminary
observed zoned tides were applied to sounding data for preliminary processing. Verified tide
data were downloaded from NOAA CO-OPS and applied with final zoning for all final
soundings and BASE surfaces.

As mentioned previously, preliminary zoning provided by CO-OPS was reviewed in light of
BMPG data acquired within the survey area during the course of the survey. The review
indicated that the CO-OPS provided zoning required modification.

C.6 Sound Speed

Observed depth is a function of the speed of sound in the water column, such that depth is
equivalent to the sound speed multiplied by the travel time of the sound pulse from transmit to
receive divided by 2. Sound speed is not a constant and varies temporally and spatially,
affected by changes in temperature, salinity and depth. Sound speed profiles are acquired to
model the speed of sound versus depth within a survey site. Improper sound speed correction
can result in inaccurate depth values and sounding positions. The sound speed correctors from
the profiles are applied to soundings to override the assumed sound speed value used during
acquisition and to calculate the depth using the actual sound speed measured in the survey site
for a defined space and time.

C.6.1 Sound Speed Profiles

The sound speed profiles used to correct the echo soundings were exclusively acquired with
an ODIM MVP30 equipped with two sensors: a sensor that measured sound speed directly at
a frequency of 10Hz during its descent through the water column and a pressure sensor for
profile depth measurement. Due to an early-project depth sensor failure in the primary MVP
sensor package, two sensor packages were employed during the course of the project. The
MVP sensors (sound speed and depth) used during mobilization testing and during the initial
alignment and settlement testing of record were calibrated July 19, 2016 (DN 201). The MVP
sensors that were used for the majority of the project were calibrated on August 3, 2016 (DN
216). Calibration reports are included in DAPR Appendix IV.
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Sound speed profile correctors were applied in CARIS HIPS using the Sound Velocity
Correction process, which employs a ray tracing algorithm to simulate refraction. The Nearest
in Distance Within Time (2-hour) profile selection method was used to determine which cast
was applied to the soundings. This method was selected to limit the effects of spatial and
temporal variation in sound speed.

C.6.2 Surface Sound Speed

Surface sound speed correctors were sent directly from the AML Micro-X sensor to the Reson
7125 TPU in real time to facilitate beam steering in equidistant mode and roll stabilization, a
feature used throughout the survey. The AML Micro-X sound speed sensor was calibrated by
the manufacturer on July 19, 2016 (DN 201).
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D. APPROVAL SHEET

LETTER OF APPROVAL

REGISTRY NOS.
H12905, H12906, H12907, AND H12908

This report and the accompanying data are respectfully submitted.

Field operations contributing to the accomplishment of Surveys H12905, H12906, H12907,
and H12908 were conducted under my direct supervision with frequent personal checks of
progress and adequacy. This report and associated data have been closely reviewed and are
considered complete and adequate as per the Statement of Work.

Digitally signed by George G.
Reynolds
Date: 2017.01.23 08:51:59 -05'00

George G. Reynolds
Ocean Surveys, Inc.
Chief of Party
January 23, 2017
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R/V Ocean Explorer Systems Layout

o Reference Point
IMU Center
POS-MV Antenna
GPS Antenna
e 7125 Transducer Phase Ctr.
Fixed Mount SSS
Towed SSS Sheave
Draft Observation Pt.
MVP Sheave

RV Ocean Explorer Offsets via Topcon . _
Total Station Survey or Measured Relative | Forward | Starboard Up LlJ
to Per Shipboard Bench k Positive Positive Positive Positive
Offsets are relative to Reference Point (RP) (m) (m) w.r.t RP w.rt
or Waterline (m) waterline (m)
RP IMUI Center 0,00 0.000 0.000 0.000 -0.480
POS MV GPS Antenna Phase Center Port 4.900 -1200 6.339 5.859
POS MV GPS Antenna Phase Center Starboard 4.883 1.239 6.333 5.853
Positioning Integnty Companson GPS Antenna 2713 0.948 7072 7.492
Phase Center

7125 Transducer Phase Center 0.629 2.870 -1.423 -1.903
Fixed Mount SSS (EdgeTech 4125) 1.139 2870 -1.016 -1.496
Towed $88 (EdgeTech 4200) P = 4

Top Of Sheave (Cable at top of sheave) 100 L0 3160 060
Starboard Side Draft Measurement Pomnt -0.325 2.542 1.975 1.495
Port Side Draft Measurement Point -0.329 -2.494 1979 1.499

Figure 1: R/V Ocean Explorer vessel offsets.
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0100 T |
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Dynamic Draft
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Figure 2. Plot of as-measured dynamic draft values and polynomial curve fit derived from July
27,2016 (DN 209) Settlement Test.
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Table 1

R/V Ocean Explorer As-Measured Dynamic Draft Correctors
Negative value indicates the boat is settling.
CARIS correctors are opposite sign.

RPM Speed Dynamic
Both Engines M/S Knots Dratft
Meters

Static 0 0 0
Troll Setting 1 1.62 3.15 -0.005
Troll Setting 2 1.86 3.62 -0.010
Troll Setting 3 2.11 4.10 -0.012
Troll Setting 4 2.26 4.40 -0.023
600 3.51 6.84 -0.049
700 3.91 7.60 -0.075
800 4.39 8.55 -0.078
900 5.02 9.76 -0.110
Table 2

R/V Ocean Explorer - Polynomial Curve Fit Dynamic Draft Correctors
As entered into CARIS HVFs

Speed Dynamic Draft
M/S Knots Meters
1.03 2.00 0.002
1.29 2.50 0.004
1.54 3.00 0.007
1.80 3.50 0.010
2.06 4.00 0.014
2.31 450 0.019
2.57 5.00 0.024
2.83 5.50 0.030
3.08 6.00 0.037
3.34 6.50 0.044
3.60 7.00 0.052
3.86 7.50 0.060
411 8.00 0.070
4.37 8.50 0.079
4.63 9.00 0.090
4.88 9.50 0.101
5.14 10.00 0.113
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(Bar Checks - Spot Sounding Checks)

Table 1
Reson SeaBat 7125 System Accuracy Tests

Conducted using Lead Line/Bar Check SN 2010B

Sounding Bar MBES Spot MBES
Date Lat, Long Depth Depth Depth Depth Comments
Systems
(m) (m) (m) (m)
3.00 3.00
4.00 4.00
5.00 5.00
6.00 6.00
A;gl?’ 29405961 N, | Lead Line, | 7.00 7.01 1434 | 1436 fﬁiﬁtkolstlé%e%ﬁ;;
(DN 229) 091 114151 W | Reson 7125 8.00 8.00 12.83 12.87 River. Calm.
9.00 9.00
10.00 10.00
12.00 12.00
14.00 14.00
4.00 4.00
5.00 5.00
Aug 23 . 6.00 6.00 _
2016 ' 293346.49 N, | Lead Line, 7.00 7.01 1299 1298 Atchafalaya River.
(DN 236) 091 135291 W | Reson 7125 8.00 8.00 Calm.
9.00 9.00
10.00 10.00
12.00 12.00
3.00 3.00
4.00 4.00
5.00 5.00
6.00 6.00
A;gl%& 29 400.30 N, Lead Line, 288 ggé 21.70 21.68 Atchafalaya River.
(DN 241) 091 14 13.34 W | Reson 7125 9.00 9.00 21.72 21.68 Calm.
10.00 10.00
12.00 12.00
14.00 14.00
16.00 16.00
3.00 3.00
4.00 4.00
5.00 5.00
Sept4, 290138.97 N Lead Line, 6.00 6.00 Offshore. Too choppy
2016 091 49 02.55 W | Reson 7125 7.00 7.00 N/A N/A for reliable spot check
(DN 248) ' 8.00 8.00 )
10.00 10.00
12.00 11.99
14.00 14.00
3.00 3.00
Sept 10, . 4.00 4.00
2016 0391 %B %715796'\\/'\/ Il?_::(;jnl}TSS 5.00 5.00 8.08 8.10 Offshore. Calm.
(DN 254) ' 6.00 6.00
7.00 7.00
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Bar MBES Spot MBES

Date Lat, Long Sounding Depth Depth Depth Depth Comments
Systems
(m) (m) (m) (m)
Septi1d, | 59090856 N | Lead Li ?1'88 ?1'88
. ea Ine, . .
(Df\(l);%z) 091 43 06.64 W | Reson 7125 |  5.00 4.99 6.79 6.81 Oftshore. Calm.
6.00 6.00
3.00 3.00
4.00 4.00
5.00 5.00
Sept25, | 59331517N | Lead Line, | °%0 6.00 Atchafalaya River.
2016 | 191140506 W | Reson 7125 | /90 7.00 1380 | 13.80 Calm
(DN 269) : 8.00 8.00 :
9.00 9.00
1000 | 10.00
12.00 | 12.00
3.00 3.00
4.00 4.00
5.00 5.00
6.00 6.00
7.00 7.00
Sept 30, .
2016 29414721 N Lead Line, 8.00 8.00 17,83 17.82 Atchafalaya River.
(DN 274) | 091130017W | oo Tos | 9.00 9.00 Calm.
1000 | 10.00
12.00 | 12.00
1400 | 14.00
16.00 | 16.00
18.00 | 18.01
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Table 2
Lead Line Accuracy Confirmation
Lead Line Bar Check Calibration Report - SN 2010B
Field unit: R/V Ocean Explorer
Date of Calibration: July 12, 2016
Method of Calibration: Steel tape used to set permanent graduation
marks on stainless steel aircraft wire.
Location: OSI
Lead Hydrographer: RMW
Lead Line Bar Check Unit of Measure: Meters
Measured by: MDB Recorded by: MJE Checked by: RMW
Graduated Marking Calibration Measurement Lead Line Corrector
(@) (b) (c=b-a)
1 1.000 0.000
2 2.000 0.000
3 3.000 0.000
4 4.000 0.000
5 5.000 0.000
6 6.000 0.000
7 7.000 0.000
8 8.000 0.000
9 9.000 0.000
10 10.000 0.000
12 12.000 0.000
14 14.000 0.000
16 16.000 0.000
18 17.990 -0.010
20 20.000 0.000
22 22.000 0.000
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Table 3
Reson Seabat 7125 Pre-Survey Patch Test Results

TEST INFORMATION

Test Date(s) / DN(s): August 16, 2016 (DN 229)

Wind / Seas: SW <10 knots; seas calm

Locality: Morgan City, LA
Sub-Locality: Atchafalaya River
Bottom Type: muddy sand (assumed)

Approximate Water Depth: ~12 meters average

TEST RESULTS

Navigation Timing Error: 0.0 seconds

Pitch Timing Error: 0.0 seconds

Roll Timing Error: 0.0 seconds

Pitch Bias: 0.00 degrees

Roll Bias: -0.32 degrees

Heading Bias: 0.50 degrees

Resulting CARIS HIPS HVF File Names: OE_MB_7125 Mainscheme.hvf,
OE_MB_7125 Investigation.hvf, OE_MB_7125 Crossline.hvf,

OE_MB_7125 Calibration.hvf
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Table 4

EdgeTech 4125 Target Positioning Accuracy Confirmation (Fixed Mount Configuration)

TEST INFORMATION

Test Date(s) / DN(s): July 26, 2016 (DN 208)

Wind / Seas: NW ~10 knots; seas calm

Locality: Noank, CT

Sub-Locality: Fishers Island Sound

Description of Bathymetry: rocky shoal with numerous discrete boulders

Bottom Type: hard with boulders

Approximate Water Depth: 11 meters

Description of Target: discrete feature (boulder)

Target Position: 4,576,436.1 N, 750,816.4 E (UTM 18N, NAD83, Meters)

Description of Positioning Method: RTK-GPS and HYPACK Genoffset.DLL

Approximate Survey Speed: 7 knots

Approximate Towfish Altitude: 10 meters

TEST RESULTS

Number of Passes on Target: eight (8)

Successful Target Detections: eight (8)

Mean Detected Position: 4,576,436.4 N, 750,816.9 E
Distance from Mean Position to True Position: 0.6 meters

Estimated Target Position Error: 0.33 meter*

Approximate 95% Confidence Radius: 1.5 meters**

*Calculated from the standard deviation of differences between individual SSS detected positions

(using the 50-meter range scale) and the MBES defined position of the discrete feature.

**Per guidance in the FPM, results were obtained by measuring the error for each detection (the
distance from the absolute target position to the detected position) and computing the sample mean
and standard deviation of the errors. The approximate 95% Confidence Radius is then the sample

mean plus 1.96 times the standard deviation.
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Table 5

EdgeTech 4200 Target Positioning Accuracy Confirmation (Towed Configuration)

TEST INFORMATION

Test Date(s) / DN(s): July 26, 2016 (DN 208)

Wind / Seas: NW ~10 knots; seas calm

Locality: Noank, CT

Sub-Locality: Fishers Island Sound

Description of Bathymetry: rocky shoal with numerous discrete boulders

Bottom Type: hard with boulders

Approximate Water Depth: 11 meters

Description of Target: discrete feature (boulder)

Target Position: 4,576,436.1 N, 750,816.4 E (UTM 18N, NAD83, Meters)

Description of Positioning Method: RTK-GPS and HYPACK Towfish.DLL

Approximate Survey Speed: 7 knots

Approximate Towfish Altitude: 7 meters

TEST RESULTS

Number of Passes on Target: five (5)

Successful Target Detections: five (5)

Mean Detected Position: 4,576,434.8 N, 750,816.6 E
Distance from Mean Position to True Position: 1.4 meters
Estimated Target Position Error: 2.1 meter*

Approximate 95% Confidence Radius: 8.7 meters**

*Calculated from the standard deviation of differences between individual SSS detected positions

(using the 75-meter range scale) and the MBES defined position of the discrete feature.

**Per guidance in the FPM, results were obtained by measuring the error for each detection (the
distance from the absolute target position to the detected position) and computing the sample mean
and standard deviation of the errors. The approximate 95% Confidence Radius is then the sample

mean plus 1.96 times the standard deviation.
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Table 6

Performance Surface Test Results

Reson 7125

PerfoT';Ttance August 25, 2016
DN 238
* 0.00 to 0.041 meters
** 0.006 to 0.018 meters
IHO Special 0
Order 100%
IHO Order 1a 100 %

(*) min/max of the mean differences between each individual beam from the performance check

line v. the 1-meter performance surface.

(**) min/max of the standard deviation of the mean differences between each individual beam

from the performance check line v. the 1-meter performance surface.
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Coordinates are referenced to UTM 15N - NAD 83, meters. Navigation checks are made relative
to a temporary control point established at the vessel’s base of operation in Morgan City, LA. The
coordinates of the temporary points were established via three Static- or Rapid-Static OPUS
sessions. The average of the precise OPUS solution for each point follows.

POMC Floating Dock Piling Nail — E 673,904.08, N 3,285,729.44

bl
Tabulation of Navigatio-lr-uaSygt:ém Performance Checks
Observed Observed Calculated Tape Difference
Time Nav. DGPS Easting Northing Distance Measure Calculated
Date UTC Che_ck- Beacon UTM 15N, UTM 15N, RP to Na}v. RP to Na_lv. vs. Tape
point NAD83 NAD83 Checkpoint | Checkpoint | Measured
(meters) (meters) (meters) (meters) (meters)

(0[?,/\113/21; 16:30 | FRMC T'i?ﬁ"ihA 673,808.3 | 3,285723.8 8.1 8.30 0.2
(0[?,/\11;/315) 9:27 P(NDZ'IC T'i?ﬁ"ihA 673,899.6 | 3,2857235 7.4 7.65 0.2
(ODSI/\IZ%LS) 17:18 P(NDZ'IC T'i?ﬁ"ihA 673,898.3 | 3,285724.0 7.9 8.15 0.2
(ODSI/\IZ%LS) 17:27 P(NDZ'IC A”%e(ton 673,899.4 | 3,285,723.7 7.4 8.05 0.6
(Ogll\lzg/jf) 12:15 P(NDZ'IC T'i?ﬁ"ihA 673,898.3 | 3,285723.4 8.3 8.40 0.1
fgﬁi@% 18:40 P(NDZ'IC TEUTE"EhA 673,898.3 | 3,285,724.1 7.8 8.10 0.3
(();/32/515 3:21 Pﬁgﬂc TEUTE"& 673,894.1 | 3,285723.7 115 11.80 0.3
fgﬁi@% 21:36 Pﬁgﬂc TEUTE"& 673,898.7 | 3,285723.4 8.0 7.75 0.3
fgﬁi@% 21:40 Pﬁgﬂc A“%';to“ 673,900.1 | 3,285723.9 6.8 7.75 0.9
(Og,/\llg/(g’) 22:29 Pﬁgﬂc A“%';to“ 673,899.8 | 3,285723.6 7.3 7.70 0.4
(Og,/\llg/(g’) 22:43 Pﬁgﬂc TEUTE"& 673,898.7 | 3,285723.5 8.0 7.70 0.3
Fgﬁg@g 18:09 Pﬁgﬂc A”%'f(to” 673,899.9 | 3,285723.3 7.4 8.00 0.6
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Observed Observed Calculated Tape Difference
Time Nav. DGPS Easting Northing Distance Measure Calculated
Date uUTC Check- Beacon UTM 15N, | UTM 15N, RP to Nav. | RP to Nav. vs. Tape
point NADS83 NAD83 Checkpoint | Checkpoint | Measured
(meters) (meters) (meters) (meters) (meters)
09/25/16 . POMC | English
(DN 269) 18:12 Nail | Turn, LA 673,898.6 3,285,723.8 7.9 8.00 0.1
09/28/16 . POMC | Angleton
(DN 272) 19:29 Nail T 673,899.9 3,285,723.2 7.6 7.97 0.4
09/28/16 . POMC | English
(DN 272) 19:36 Nail | Turn, LA 673,898.5 3,285,723.8 7.9 7.97 0.1
09/30/16 . POMC | Angleton
(DN 274) 12:48 Nail T 673,899.3 3,285,723.5 7.6 7.80 0.2
09/30/16 . POMC | English
(DN 274) 12:51 Nail | Turn, LA 673,898.3 3,285,723.3 8.5 7.80 0.7
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POS/MV GAMS Calibration Report
7-26-2016 (DN208)

POS/MV Calibration Report
Field Unit: Ocean Explorer
SYSTEM INFORMATION
Vessel: Ocean Explorer
Date: 7/126/12016 Dn: 208
Personnel: RMW, CLR, BLJ
PCS Serial # 6415
IP Address: 10.69.10.6
POS controller Version (Use Menu Help > About) 8.45
POS Version (Use Menu View > Statistics) MV 320 ver 5
GPS Receivers
Primary Receiver SN: 5403C86282
Secondary Receiver SN: not shown in software
CALIBRATION AREA
Location: MNoank, CT D M S
Approximate Position: Lat 41 19 0
Lon 71 59 53
DGPS Beacon Station: Moriches, NY
Frequency: 293
Satellite Constellation (Use View> GPS Data)
Primary GPS (Port Antenna) N
HDOP: 0.992 e i s ismands
————————— Wate Marrow Lans RTK
VDOP: 1.542 HOoP e L onas S
- 5 31501
Sattelites in Use: 17 Lt \
1,3,7,8.11,17,19,22,28,30,4,9,10,11,19,20,21,11,14 o I
i 1e0a
PDOP 1.855 (Use View> GAMS Solution) . . TesssssuTe e
Note: Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS
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|POS/IMV CONFIGURATION
Settings
Gams Parameter Setup (Use Setlings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector
2.425 Two Antenna Separation (m) 0.008 X Component (m)
0.50 Heading Calibration Threshold -2.425  |YComponent (m)
0 Heading Correction -0.020  |Z Component (m)

Configuration Notes: GAMS needed re-calibration because the leverarm for IMU to Port Antenna was incorrect

|POS/MV CALIBRATION
Calibration Procedure: {Refer to POS MV V3 Installation and Operation Guide, 4-25)
Start time: 17:05
End time: 17:10
Heading accuracy achieved for calibration: 0.016

Calibration Results:

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
POS/MV Post-Calibration Values Baseline Vector
2.425 Two Antenna Separation (m) 0.008 X Component (m}
0.500 Heading Calibration Threshold -2.425 YComponent (m)
0.000 Heading Correction -0.020 Z Component (m)
GAMS Status Online? X
Save Setlings? X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: OE_post-cal-07-26-2016.nvm
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POS/MV GAMS Calibration Report
7-31-2016 (DN213)

POS/MV Calibration Report

Field Unit: Ocean Explorer

SYSTEM INFORMATION

Vessel:

Ocean Explorer

Date:

Personnel:

7/31/2016

RMW, MJE

PCS Serial #
IP Address:

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver
Secondary Receiver

POS controller Version (Use Menu Help > About)

MV 320 ver 4

SN: 4834K32758

. 4384K3279

Dn:

213

7.92

CALIBRATION AREA

Location:

Moank, CT

Frequency:

Satellite

HDOP:
VDOP:

PDOP

Approximate Position:

DGPS Beacon Station:

Constellation

Primary GPS (Port Antenna)

0.992
1.542

Sattelites in Use:
2,569,1219,25294,56,19,20,21

2132

Lat
Lon
Moriches, NY

41

19

17

71

58

31

293

{Use View= GPS Data)

(Use View>= GAMS Solution)

reees

Formary Fatams

-

S vy Pl e | Aoy 1

Moce
HOOP
VDoP

30 CA mode
am
LiM

R a2

tut.
2 Laency f8ec)  .969

o T8
ot (e AT

L ]
Rolecors o 5 gcm A
Comystam Loty (14 .000

20 d00d UTC
Count

o

N

Note: Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS

DAPR - Appendix 111



OPR-K354-KR-16 OCEAN SURVEYS, INC.

[POS/MV CONFIGURATION
Settings
Gams Parameter Setup (Use Setlings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector
2.425 Two Antenna Separation (m) 0.008 X Component (m)
0.50 Heading Calibration Threshold -2.425 _ |YComponent (m})
0 Heading Correction -0.020 Z Component (m)
Configuration Notes:
POS/MV CALIBRATION
Calibration Procedure: {Refer to POS MV V3 Installation and Operation Guide, 4-25)
Start time: 22:02
End time: 22.07
Heading accuracy achieved for calibration: 0.016
Calibration Results:
Gams Parameter Setup {Use Settings > Installation > GAMS Intallation}
POS/MV Post-Calibration Values Baseline Vector
2.421 Two Antenna Separation (m) 0.014 X Component (m}
0.500 Heading Calibration Threshold -2.421 YComponent (m)
0.000 Heading Correction -0.019 Z Component (m)
GAMS Status Online? X
Save Setlings? X
Calibration Notes:
Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: OE_post-cal-07-31-2016.nvm
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POS/MV Settings and Configuration

Input/Qutput Ports Set-up *
|comz | com3 | coms4 | coms |
Baud Rate iarlty Data Bits Stop Bits l{ilnw Contraol
9600 — o, C TBits | | & 1Bit e
" Ewven _ . " Hardware
 Odd @ 8Bits || € 2Bits | | ~ xONXOFF
NMEA Qutput
Output Select P — Roll Positive Sense
SGPGST n ate Rate # Port Up " Starboard Up
NMEA v SGPGGA 1Hz ~] : i
$GPHDT Pitch Positive Sense
v SGPZDA f« Bow Up = Stern Up
Talker ID .
SGPVTG GP = Heave Positive Sense
?E’”@HB W * Heave Up " Heave Down
Input Select
None -
Close Apply
Input/Qutput Ports Set-up X
com1 com3 | coms | coms |
Parity Data Bits Stop Bits Flow Control
Baud Rate
2800 — @ C 7Bits | |~ 1Bit e
" Even . . " Hardware
 Odd ¢ 8Bits || 2Bits | | ~ XONXOFF
NMEA Output
Output Select i T Roll Positive Sense
SGPGST () ate Rate * Port Up " Starboard Up
NMEA - SGPGGA 10Hz = : —
¥ SGPHDT Pitch Positive Sense
SGPZDA * Bow Up " Stern Up
Talker ID i
BGPVTG m Heave Positive Sense
?EAgHB v * Heave Up ¢ Heave Down
Input Select
Mone hd
Close ‘ Apply |
-7- DAPR - Appendix 111
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Input/Output Ports Set-up *
comt | comz COM3 | coms | coms |
Baud Rate Interface E:arity— Data Bits Stop Bits (Iiow Control
9600 - & RS232 #None C 7Bits || 1Bit - o
" Even " Hardware
Output Select
INone vl
Input Select Base GPS Input
[Base1GPs ] | MmputType  [CMRor CMR+ -
Line
’7(:‘ Serial " Modem Modem Settings
Close | Apply
Input/Cutput Ports Set-up *
COM1 | com2 | coms COMM
Baud Rate Interface— E’-arity— Data Bits Stop Bits (liow Control
115200 |5 & RS232 - oz € 7Bits || #1Bit - oz
= Even " Hardwara
~Binary Output
Output Select Ve e Roll Positive Sense
Im Update Rate - & Sensor 1 % Port Up " Starboard Up
100 Hz " Sensor 2 Pitch Positive Sense
& Bow Up ¢ Stern Up
Formula Select H Positive 5
eave Positive Sense
ITSS‘1 j % Heave Up " Heave Down
Input Select
INone 'I
Close Apply
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Input/Output Ports Set-up >
com1 | com2 | coms | coms i€
Baud Rate Parity——— Data Bits Stop Bits Flow Control
5500 = @ Mone || = 78its || @ 1Bt & None
" Even _ _ " Hardware
€ Odd @ 8Bits || C28Bits || ¢ yoNKOFF
~MNMEA Output
Output Select = e U . Raoll Pasitive Sense
SGPGST ~ ate Rate & Port U " Starboard U
NMEA M [ $GPGGA im Hz | : £ :
¥ SGPHDT Pitch Positive Sense
] $GPZDA « Bow Up  Stern Up
Talker ID —
[ 8GPVTG m Heave Positive Sense
E%Eﬁ@HE v % Heave Up " Heave Down
Input Select
INone 'I
Close | Apply |
Events *
Event 1 | Event 2| Event 3 | Event 4| Event & | Event E-|
Heave Filter x Edge Tngger———"7 & il Time (msec)
* Positive Iﬁ‘_
U | e
" Megative
Heave Bandwidth (sec) I‘IU.EIEIU
Damping Ratio IU.?U? ~PPS Out
Polarity———
& Positive Pulse Pulse Width (msec)
 Negative Pulse 63 |+
Close | Apply  Pass through

Close | Apply |
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Lever Arms & Mounting Angles X
Lever Arms & Mounting Angles lSensor Mounting I Tags, AutoStartl
Ref. to IMU Target IMU Frame w.r.t. Ref. Frame Target to Sensing Centre Resulting Lever Arm
X(m) |0.000 X (deg) 1.530 X(m) |-0.008 X(m) |-0.008
Y(m) o000 Yideg) [0 Ym o031 Y 503
Zm o000 2(d=a)  57gog Zm o930 Zm oz
Ref. to Primary GNSS Lever Arm Ref. to Vessel Lever Arm Ref to Centre of Rotation Lever Arm
X(m) [4833 X (m) 0.000 X (m) 0.000
Y(m) [1.239 Y(m) [p.000 Y (m) 0.000
Z{m)  |6.333 Z(m)  o.000 Z{m) 0.000
Compute IMU w.r.t.
Notes: 1. Ref = Reference Ref. Migalignment
2. w.rt. = With Respect To
3. Reference Frame and Vessel Frame are co-aligned [~ Enable Bare MU
= | Close Wiew |
In Mavigation Mode | to change parameters go to Standby Mode |
Lever Arms & Mounting Angles x
Lever Arms & Mounting Angles  Sensor Mounting }Tags, AutoStan]
Ref. to Aux. 1 GNSS Lever Arm-) ~Ref. to Aux. 2 GNSS Lever Arm
X(m) [p.000 X (m) 0.000
Yi(m) |o.000 ¥ (m) 0.000
Z(m) o000 Z(m) 0.000
Ref. to Sensor 1 Lever Arm Sensor 1 Frame wert. Ref. Frame
X(m) 0.000 X (deg) 0.000
Y(m) {0.000 Y (deg) 0.000
Z(m)  [o.000 Z (deg) 0.000
Ref. to Sensor 2 Lever Arm Sensor 2 Frame w.rt. Ref. Frame
X(m) |0.000 X (deg) 0.000
Yi(m) |o.000 Y (deg) 0.000
Z(m) fo.000 Z (deg) 0.000
&8 ‘ Close | Wiew |
In Mavigation Mode | to change parameters go to Standby Mode |
Lever Arms & Mounting Angles >
Lever Arms & Mounting Angles | SensorMounting  Tags, AutoStart
Time Tag 1 Time Tag 2
' POS Time € POS Time
" GPS Time
" GPS Time
& UTC Time
# UTC Time " User Time
AutoStart
" Disabled
* Enabled
= Wiew
In Mavigation Mode | to change parameters go to Standby Mode |
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User Parameter Accuracy E[

—RMZ Accuracy
Attitude (deg)  [0.050

Heading (deg) IIII.EIEEI
Pasition (i) |2.IIIIIIIZI
Walocity (mis) IIII_EEIEI

Cloge | Apply |

f
Frimary GMNSS Receiver |Sec0ndary GNES Receiverl
~Primary GN35——— GN55 1 Port
GNSS Output Rate Baud Rate
1Hz = || Jeeno |
Parity—— Data Bits Stop Bits
@ None | | ~7gits | | & 1Bi
rAuta Configuration ¢ Evan
&+ Enahbled ~ Odd &+ 8 Bits " 2 Bits
" Disabled
x
Primary GMSS Receiver Secondary GMSS Receiver |
—=econdary GNSS FGMNES 2 Port
GMNSS Output Rate Baud Rate
1 Hz =l | jse0o |
Parity—— Data Bits Stop Bits
©MNome | | ¢ 7gits | | & 1Bit
rAuto Canfiguration " Evan
{ Enabled © 0dd = B Bits 2 Bits
" Disabled

- C|DSE Apply

-11- DAPR - Appendix Il



OPR-K354-KR-16 OCEAN SURVEYS, INC.

DAPR Appendix IV

Sound Speed Sensor Reports

DAPR - Appendix IV



OPR-K354-KR-16 OCEAN SURVEYS, INC.

4 " OCEANOGRAFPHIC
Xchange your oid ideas

Certificate of Calibration

Customer: Electronic Sales of New England
Asset Serial Number: 201527

Asset Product Type:  SveXchange™ Calibrated Sensor
Calibration Type: Sound Velocity

Calibration Range: 1375 to 1625 m/s

Calibration RMS Error: 002

Calibration ID: 201527 999999 201527 190716 094505

Installed On:

Coefficient A: o,000000E+0 Coefficient H:  1.947219E-7
Coefficient B: 5 g00000E+0 Ceefficient I:  0.000000E+0
CoefficientC: g 40311267 | Coefficient): 0.000000E+0
Coefficient D: 1.945740E-7 Coefficient K:  0.000000E+0
Coefficient E: .1 74753765 - Coefficient L: 0.000000E+0
Coefficient F: 1.951373E-7 Coefficient M: 0.000000E+0
Coefficient G: 5.266942E-7 Coefficient N: 0.000000E+0

Calibration Date (dd/mm/yyyy): 19/7/2016
Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that Xchange'" sensor-heads may be installed on assets other than the one listed above; this
. calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post-
processing software that you use, if necessary. Older generation Instruments may require configuration files, which are

avallable for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L5X6 CANADA
T:+1-250-656-0771 F: +1-250-655-3655 Emall: service@AMLoceancgraphic.com

Figure 1. Sensor Calibration Certificate - AML SV.Xchange Sensor SN 201527 installed on the
AML Micro-X mounted on the Reson 7125.
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) v’ OCEANOGRAPHIC
Xchange your old ideas

Certificate of Calibration

Customer: Electranic Sales of New England
Asset Serial Number: 203108
Asset Product Type:  syveXchange™ Calibrated Sensor

Calibration Type: Sound Velocity

Calibration Range: 1375 to 1625 m/s

Calibration RMS Error: .003

Calibration ID: 203108 999999 203108 190716 094420

Installed On:

Coefficient A: p,000000E+0 Coefficient H: 1.946239E-7
Coefficient B: ( 000000E40 Coefficient:  ,000000E+0
Coefficient C: 713143167 CoefficientJ:  0.000000E+0
Coefficient D: 1.945474€-7 Coefficient K: 0.000000E+0
Coefficient E: _1,811335€-5 Coefficient L:  0.000000E+0
Coefficient F; 1.953549E-7 Coefficient M: 0.000000E+0
Coefficient G: 8.442229E-7 Coefficient N: 0.000000E+0

Calibration Date {dd/mm/yyyy): 19/7/2016
Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets, If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values In any post-
processing software that you use, If necessary. Older generation instruments may require configuration files, which are
available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. VBL5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Figure 2. Sensor Calibration Certificate - AML SV.Xchange Sensor SN 203108 installed on the
AML Micro SVPT 7786 used on the ODIM MVP.
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Xchange your old ideas

Certificate of Calibration

Customer: Electronic Sales of New England

Asset Serial Number:  go7786

Asset Product Type:  Micro SVTP, Fixed Sensors, for Brooke MVP -
Calibration Type: Pressure

Calibration Range: 200 dBar

Calibration RMS Error: 0145

Calibration ID: 007786 999999 007786 190716 113023
Installed On:

Coefficient A: .2 578497E+1 Coefficient H:  0.000000E+0
Coefficient B: g ooo000E+0  Coefficient I: 3.029604E-10
Coefficient C: 5 000000E+0 : CoefficientJ:  0.000000E+0
Coefficient D: (,000000E+0 Coefficient K:  0.000000E+0
Coefficient E: 3 778248€-3 Coefficient L: 0.000000E+0
Coefficient F: 0.000000E+0 Coefficient M: -5.527654E-15
Coefficient G: 0.000000E+0 Coefficient N: 0.000000E+0

Calibration Date (dd/mm/yyyy): 19/7/2016
Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that Xchange™™ sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary, Older generation instruments may require configuration files, which are
available for downicad at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C, V8L5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Figure 3. Sensor Calibration Certificate - MVP Micro SVTP Pressure Sensor on SN 7786 used
on the ODIM MVP.
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v, OCEANOGRAPHIC
Xchange your old ideas
Certificate of Calibration
Customer: Electronic Sales of New England

Asset Serial Number: go7786
Asset Product Type:  Micro SVTP, Fixed Sensors, for Brooke MVP -

Calibration Type: Temperature

Calibration Range: -2 to+32 Dec C

Calibration RMS Error: .001

Calibration ID: 007786 999999 007786 180716 212744

Installed On:

Coefficient A: .g 719194E+0 Coefficient H:  0,0000008+0
Coefficient B: g gsaz67t.4 Coefficient I 0,000000E+0
Coefficient C: g 723720e.9 ' CoefficientJ:  0.000000E+0
Coefficient D: 3 050998E-13 Coefficient K: 0.000000E+0
Coefficient E: 3 537981£-18 Coefficient L: 0.000000E+0
Coefficient F; 2.195729E-23 Coefficient M: 0.000000E+0
Coefficient G: -6.397494E-29 Coefficient N: 0.000000E+0

Calibration Date (dd/mm/yyyy): 18/7/2016
Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that Xchange™ sensor-heads may be Installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets, If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for dewnload at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. VBL5X6 CANADA
T: +1-250-656-0771 F:+1-250-655-3655 Email: service@AMLoceanographic.com

Figure 4. Sensor Calibration Certificate - MVP Micro SVTP Temperature Sensor on SN 7786
used on the ODIM MVP.
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Certificate of Calibration
Customer: Electronic Sales of New England

Asset Serial Number: 201525
Asset Product Type:  svsXchange™ Calibrated Sensor

Calibration Type: Sound Velocity

Calibration Range: 1375 to 1625 m/s

Calibration RMS Error: 006

Calibration ID: 201525 999999 201525 030816 112450

Installed On:

Coefficient A: .000000E+0 Coefficient H:  1.946828E-7
Coefficient B: ( ggooooe+o Coefficientl:  0,000000E+0
Coefficient C: g 184631F-7 Coefficient): 0.000000E+0
Coefficient D: 1.946342E-7 Coefficient K:  0,000000E+0
Coefficient E: _1 739031F-5 Coefficient L:  0.000000E+0
Coefficient F: 1.951800E-7 Coefficient M: 0.000000E+0
Coefficient G: 7.035665E-7 Coefficient N: 0.000000E+0

Calibration Date (dd/mm/yyyy): 3/8/2016

Certified By:

Robert Haydock
President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C, V8L5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Figure 5. Sensor Calibration Certificate - AML SV.Xchange Sensor SN 201525 installed on the
AML Micro SVPT 7777 used on the ODIM MVP.
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Certificate of Calibration

Customer: Electronic Sales of New England

Asset Serial Number:  po7777

Asset Product Type:  Micro SVTP, Fixed Sensors, for Brooke MVP -
Calibration Type: Pressure

Calibration Range: 200 dBar

Calibration RMS Error: 0119

Calibration ID: 007777 999999 007777 030816 142729

Installed On:

Coefficient A: 7.330104€+3 Coefficient H:  4.160638E-16
Coefficient B: 4 gr3319¢.1 Coefficient I:  _1,901992E-6
Coefficient C: 4 g5ggose-5 Coefficient J:  1.260468E-10
Coefficient D: _7.818596E-11 Coefficient K: -2.784536E-15
Coefficient E: _4 gpg185€-2 Coefficient L:  2.050525€-20
Coefficient F: 3.180522E-6 Coefficient M: 0.000000E+0
Coefficient G: -6.331035E-11 Coefficient N: 0.000000E+0

Calibration Date (dd/mm/yyyy): 3/8/2016
Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. if this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are
available for download at cur Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. VBL5X6 CANADA
T: +1-250-656-0771 F:+1-250-655-3655 Email: service@AMLoceanographic.com

Figure 6. Sensor Calibration Certificate - MVP Micro SVTP Pressure Sensor on SN 7777 used
on the ODIM MVP.
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Certificate of Calibration
Customer: Electronic Sales of New England

Asset Serial Number:
Asset Product Type:
Calibration Type:
Calibration Range:
Calibration RMS Error:

007777

Micro SVTP, Fixed Sensors, for Brooke MVP -
Temperature

-2t0+32 DecC

0005

Certified By:

Calibration Date (dd/mm/yyyy):

Calibration 1D: 007777 999999 007777 030816 212802

Installed On:

Coefficient A: _g.911927E+0 Coefficient H: 0.000000E+0
Coefficient B: g gpp3ssE.a Coefficientl:  0,000000E+0
Coefficient C: g 1595089 CoefficientJ: 0.000000E+0
Coefficient D: 1 791504E-13 Coefficient K:  0,000000E+0
Coefficient E: 5 97340818 Coefficient L:  0.000000E+0
Coefficient F: 1.455989E-23 Coefficient M: 0.000000E+0
Coefficient G: -2.853210E-29 Coefficient N: 0.000000E+0

3/8/2016

Robert Haydock
President, AML Oceanographic

AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are
available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. VBLSX6 CANADA

T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Figure 7. Sensor Calibration Certificate - MVP Micro SVTP Temperature Sensor on SN 7777

used on the ODIM MVP.
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v’ OCEANOGRAPHIC
Xchange your old ideas

Certificate of Calibration

Customer: Electronic Sales of New England
Asset Serial Number: 203516

Asset Product Type:  syeXchange™ Calibrated Sensor
Calibration Type: Sound Velocity

Calibration Range: 1375 to 1625 m/s

Calibration RMS Error: 001

Calibration ID: 203516 999999 203516 190716 094618

Installed On: 025001

Coefficient A: 0.000000E+0 Coefficient H: 1.946142E-7
Coefficient B: g gapo0oE+0 Coefficient I:  0.000000E+0
Coefficient C: g 479591€-7 CoefficientJ:  0.000000E+0
Coefficient D: 1,946301E-7 Coefficient K: 0.000000E+0
Coefficient E: .1 810932E-5 Coefficient L:  0.000000E+0
Coefficient F: 1.954303E-7 Coefficient M: 0.000000E+0
Coefficient G: 1.046788E-6 Coefficient N: 0.000000E+0

Calibration Date (dd/mm/yyyy): 19/7/2016
Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with-equipment referenced to
traceable standards. Please note that Xchange™ sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. I this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument's coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. VBL5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Figure 8. Sensor Calibration Certificate - AML SV.Xchange Sensor SN 203516 installed on the
AMLBase-X profiler SN 25028.
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Xcehange your old ideas

Certificate of Calibration

Customer: Electronic Sales of New England

Asset Serial Number: 303077

Asset Product Type:  peXchange™ Calibrated Sensor, 100 dBar
Calibration Type: Pressure

Calibration Range: 100 dBar

Calibration RMS Error: 0064

Calibration ID: 303077 999999 303077 190716 124338

Installed On: 025016

Coefficient A: _1.251091E+1 Coefficient H: 0,000000E+0
Coefficient B: ,000000E+0 Coefficient I:  5.112423¢-11
Coefficient C: g goooooE+0 CoefficientJ:  0.000000E+0
Coefficient D: g,000000E+0 Coefficient K:  0.000000E+0
Coefficient E: 1.906781E-3 Coefficient L:  0.000000E+0
Coefficient F: 0.000000E+0 Coefficient M: -5.844958E-16
Coefficient G: 0.000000E+0 Coefficient N: 0.000000E+0

Calibration Date (dd/mm/yyyy): 19/7/2016
Certified By:

Robert Haydock
President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that )(::hange':M sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, If necessary. Older generation instruments may require configuration files, which are

available for download at cur Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. VBLSX6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

Figure 9. Sensor Calibration Certificate - AML P.Xchange Sensor SN 303077 installed on the
AMLBase-X profiler SN 25028.
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